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1

About this Document

Purpose

This guide describes the single-host installation of SAP NetWeaver 7.0 Search and Classification (TREX) using
the installation tool Software Provisioning Manager 1.0 SP22 (“installer” for short), which is part of SL Toolset
1.0 SP22.

The target audience for the guide consists of system administrators and consultants.

The guide is structured as follows:

The section Implementation Considerations [page 5] explains what you need to take into account before
the installation.

The section Naming Conventions [page 13] contains information on special naming conventions used in
this guide.

The section Checklists for the Installation [page 15] contains a separate checklist for each installation
variant, including an overview of the installation steps.

The section Checklists for the Installation [page 15] describes how you plan, prepare, and perform the
installation of the server software. It also describes the configuration steps that youhave to perform
immediately after the installation.

The section Installing a TREX Global File System with a First TREX Instance [page 32] describes how
perform out the installation of the client software, if this is necessary. It also describes the configuration
steps that you have to perform on the client side.

The section Installation Check [page 92] describes how to check whether the installation of the server
software was successful.

The section Additional Information [page 96] contains information on troubleshooting problems that
might occur during the installation and explains how to control the installation from another host. It also
describes how to start, stop, and uninstall TREX.

Constraints

Additional configuration steps may be necessary depending on the application for which you are installing
TREX. These additional steps are not described in this guide. You can find them in the documentation on the
application in question.
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2 Implementation Considerations

Refer to the following information before starting the installation:

Master Guides

If you are installing TREX as part of a mySAP Business Suite solution, a business scenario, or an IT scenario,
familiarize yourself with the relevant master guide available at https://help.sap.com before beginning the
installation.

Master guides are the central documents for implementing mySAP Business Suite solutions, business
scenarios, and IT scenarios. They list the components and third-party applications that are necessary for a
business scenario or an IT scenario, and refer to any necessary installation and upgrade guides. They also
define the installation sequence.

Integration of TREX and Applications That Use It [page 5]
Bl Accelerator (BIA) [page 7]

2.1 Integration of TREX and Applications That Use It

TREX is based on a client/server architecture. The client software is integrated into the application that uses
the TREX functions, and allows communication with the TREX servers. The TREX servers execute the requests
of the clients: They index and classify documents and respond to search queries.

TREX offers an ABAP and a Java client. This allows ABAP and Java applications to use TREX functions. ABAP
and Java applications communicate with the TREX servers using different protocols and components.

e ABAP applications communicate with TREX servers using the RFC protocol. Communication takes place
using an instance of the SAP Gateway and an RFC server.

e Java applications communicate with TREX using the HTTP or HTTPS protocol. This communication takes
place using a Web server that is enhanced with TREX-specific functions.

RFC and Web servers have similar functions: They receive the requests of the application, convert them to a
TREX-internal format, and send them on to the responsible TREX server.

The graphic below depicts the interaction between applications and TREX.
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1 Note

There is no dependency between TREX and the application using TREX with regard to the operating system
used. You can install TREX on a different operating system to the application that accesses TREX.

Caution

Use all installable units within SAP NetWeaver that have the same support package level. Only by using the
same support packages you can ensure the integration and smooth collaboration between all systems,
stand-alone engines, and clients within SAP NetWeaver.

Connecting TREX to More Than One Application

In principle, you can connect one TREX system to more than one application.
Note the following:

e The TREX system must have appropriate dimensions so that it can process the load of all the applications.
e You must take organizational measures to ensure that the applications use separate index namespaces.

SAP NetWeaver Standalone Engine Search and Classification TREX 7.0 - Single Host
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2.2 Bl Accelerator (BIA)

Bl Accelerator: a Key Functionality for High-Performance Analytics

The Bl accelerator is based on TREX technology. It is the aggregation engine for the accelerator functionality of
SAP NetWeaver 7.0 Business Intelligence (Bl), a key functionality for high-performance analytics, which
belongs to the Enterprise Data Warehousing IT scenario.

For more information see the SAP Net Weaver Master Guide on SAP Service Marketplaceservice.sap.com/
installnw70 .

A TREX aggregation engine for processing structured business data powers this functionality. The data of the
Bl InfoCubes is replicated to the TREX engine and stored as TREX indexes. Bl accelerator benefits companies
that handle large volumes of data. The average response time is significantly improved in comparison with
traditional approaches.

The following graphic depicts the relationship between the Bl accelerator and the Bl System:

SAP NetWeaver 2004s RFC SAP NetWeaver 2004s
Bl accelerator Bl System

How To Use, Install, and Update the Bl Accelerator

e Use only with BI
The Bl accelerator is based on TREX technology. For the Bl accelerator, you require an installation based on
a 64-Bit architecture. The hardware partners deliver this variant in preconfigured form as the Bl
accelerator box. You must note that a TREX installation configured for searching metadata and documents
based on a 32-Bit architecture cannot be used for the Bl accelerator. In turn, you cannot use a Bl
accelerator box to search metadata and documents. In order to use both the search functions and the BI
accelerator, you require two separate installations.
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Caution

You cannot use the Bl accelerator for the regular TREX search and classification functions.

In order to use the preinstalled Bl Accelerator Box, you must enter the fixed RFC destination defined for
this purpose (default: TREX_HPA) in table RSADMINA.

e |nstallation on preconfigured hardware
The Bl accelerator is a special LINUX 64-Bit version of SAP NetWeaver 7.0 Search and Classification
(TREX), which is delivered on preconfigured hardware. All installation and configuration steps will be done
during the preconfiguration of the hardware by the hardware vendor.

e Download update from SAP Service Marketplace
Bl customers have to update and patch the Bl accelerator. They can download the updates and patches for
the Bl accelerator from the SAP Service Marketplace at:

https://launchpad.support.sap.com/#/softwarecenter# | Support Packagea and Patches j» Browse our
Download Catalog » SAP NetWeaver and complementary products » SAP NetWeaver » SAP NETWEAVER
70<Release> ¥ Entry by Component » Search and Classif. (TREX) » TREX 7.00 ¥ Support Package
Patches ¥ Linux on x86_64 64bit J

1 Note

For more information about the Bl accelerator, see the following SAP Notes:

e SAP Note 883726 TREX 7.0: Central Note Bl accelerator

e SAP Note 875400#% TREX 7.0: Installing SAPNetWeaver7.0 Bl accelerator

e SAP Note 883725 TREX 7.0#% : Updating SAP NetWeaver 7.0 Bl accelerator
e SAP Note 902533 TREX 7.0# : HowToGuide Connecting/Operating BIA Box
e SAP Note 984034 TREX 7.0# : Bl Accelerator High Availability

Bl Accelerator: Preconfigured Blade System

The Bl accelerator is installed on a preconfigured blade system. A blade system consists of hosts in the form of
server blades. The server blades are connected to centralized disk storage. This is referred to here as a file
server, regardless of the underlying hardware.

The special feature of a TREX installation on a blade system is that both the TREX software and the TREX data
can be stored centrally. This means that the software is installed only once on the file server. Maintaining the
system is efficient because you have to implement software updates once only.

All server blades on which TREX is running access the same program files. However, each server blade has its
own configuration files. The configuration files in the directory <TREX DIR> are only used as templates. A
script creates a separate subdirectory for each server blade and copies the configuration files to this
subdirectory. The graphic below depicts how data, programs, and configuration files might be stored in a Bl
accelerator blade system.
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3 Minimal and Distributed TREX Systems

Minimal TREX System (Single-Host Installation)

A minimal system consists of one TREX instance (one installation of the server software).You can use a minimal
system as a demo, test, and production system.

1 Note

For a production system, SAP recommends that you install the server software on a single host that is used
exclusively for TREX.

Caution

If TREX is running on the same host as other components, you must make sure of the following:

® Thereis enough main memory for all components.
e TREX can use the required main memory space exclusively.

Sizing

The required hardware for the server software depends on the following factors:

e How many documents of what type are to be indexed?
e What quantities of documents are to be indexed initially, and what quantities during routine operation?
e How many search queries are expected? How many parallel search queries are expected?

Plan the required number of hosts and the equipping thereof with your SAP hardware partner. Use the
information in Hardware and Software Requirements [page 21] as a basis for this.

Distributed TREX System (Multiple Host Installation)

Search and Classification (TREX) consists of a client component and a server component. The server
component is based on a flexible architecture that allows a distributed installation. You can use a distributed
installation to achieve the following:

® | oad balancing
You can distribute the search and indexing load among several hosts.

e High availability

SAP NetWeaver Standalone Engine Search and Classification TREX 7.0 - Single Host
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You can make sure that both indexing and searching are highly available.

Caution

Your TREX system can quickly reach its performance limit if you install TREX on a single serverin a
productive scenario with large document sets and a large number of search queries. SAP therefore
recommends that you calculate the expected load and availability requirements for your TREX system early

on in the planning process and start with a distributed TREX installation immediately if that is what you
require.

Caution

In a distributed scenario, the same TREX version and patch level must run on all TREX hosts. Mixed
installations with different TREX versions are not supported.

For more information on installing and configuring a distributed TREX system, see the SAP NetWeaver

Distributed Search and Classification (TREX) Systems Installation Guide at https://help.sap.com/viewer/p/
SAP_NetWeaver_TREX

SAP NetWeaver Standalone Engine Search and Classification TREX 7.0 - Single Host
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4 Installation and Configuration of Server
and Client Software

Installation of the Server Software

The TREX servers can be used by one or more applications. When you are installing TREX, you need to know
the type of application and communication protocol. There are the following possibilities:

e The TREX servers are only used by Java applications.
Since Java applications communicate with the TREX servers using HTTP, you definitely need to carry out
the installation steps that enable an HTTP connection.

e The TREX servers are only used by ABAP applications.
Since ABAP applications communicate with the TREX servers using RFC, you definitely need to carry out
the installation steps that enable an RFC connection.

o The TREX servers are used by Java and ABAP applications.
In this case, execute the installation steps necessary for an HTTP and an RFC connection.

Example

The documents to be indexed are sent by an ABAP application to TREX. The search takes place using a
Web application (Java application).

This guide contains a checklist with an overview of necessary installation steps for each case.

Installation of the Client Software

e ABAP client
The ABAP client is part of the SAP system, and must not be installed separately. The necessary
configuration is described in this guide.

e Javaclient
As a TREX service, the Java client is part of the J2EE engine of the SAP NetWeaver Application Server and
does not have to be installed separately. The necessary configuration is described in this guide.

SAP NetWeaver Standalone Engine Search and Classification TREX 7.0 - Single Host
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5 Naming Conventions

Terminology
TREX host Host on which the TREX server software is installed
TREX instance One installation of the TREX server software
software provisioning manager 1.0 A tool that performs software provisioning processes such

as installation, uninstallation, system copy, or system trans-
formation. Software Provisioning Manager is delivered with
the Software Logistics Toolset 1.0, available at:

(“the installer” for short)

https://support.sap.com/sltoolset®ir | ¥ System

Provisioning |
Variables
Variable ’ Meaning
<SAPSID> System ID in uppercase letters
<sapsid> System ID in lowercase letters
<TREX DIR> Installation directory for TREX. The path to the directory is:
® OnUNIX: /usr/sap/<sapsid>/
trx<instance_ number>
® OnWindows: <disk drive>:\usr\sap\<SAPSID>
\TRX<instance number>
<SAP System Directory> SAP system directory:
® OnUNIX: /<sapmnt>/<sapsid>
® OnWindows: <disk drive>:\usr\sap\<SAPSID>
\SYS
<0s> Name of the operating system in a path.
User <sapsid>adm Operating system user that you log on with to administrate
TREX.
User SAPService<SAPSID> Operating system user under which the TREX processes
run.

SAP NetWeaver Standalone Engine Search and Classification TREX 7.0 - Single Host
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Variable Meaning

Operating system user that you use to log on to the host on

User <j2eeadm>
which the J2EE Engine is running.

The following example shows how variables are used:

Example

Go to the directory Go to the directory /usr/sap/<sapsid>/trx<instance number>.

If the SAP system ID is kb1 and the instance number is 01, you have to go to the directory /usr/sap/kb1/
trx01.

Path specifications

The forward slash (/) is usually used in path specifications such as <TREX DIR>/<host name>/
sapprofile.ini.

Commands

Commands such as script calls are sometimes distributed over several lines in this documentation. When you
execute the commands, enter them in one line.

SAP NetWeaver Standalone Engine Search and Classification TREX 7.0 - Single Host
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6 Checklists for the Installation

Purpose

Use the tables below as checklists for the installation of the system. All necessary installation phases (planning,
preparation, installation, and post-installation activities) are listed in these tables.

Use the links to the general descriptions of actions and to additional information that will help you when
executing the actions. By doing this, you ensure that you do not overlook any important information.

Process Flow

Print the relevant checklists:

e |nstallation with HTTP Connectionlnstallation with HTTP Connection [page 15]
e |[nstallation with RFC ConnectionlInstallation with RFC Connection [page 17]
e |nstallation with HTTP and RFC Connectionsinstallation with HTTP and RFC Connections [page 18]

Carry out the installation steps in the order specified in the tables.

e \When carrying out an obligatory step during the installation, follow the link to the relevant section.
® Then carry out the work steps described there.

e When the installation step has been successfully completed, place a check ( v ) next to the relevant entry
in the table in order to record your progress.
e Then continue with the next step listed in the table.

6.1 Installation with HTTP Connection

Server Side

Installation Planning

Check hardware and software requirements (see Hardware and Software Requirements [page 21]).

SAP NetWeaver Standalone Engine Search and Classification TREX 7.0 - Single Host
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Check what documentation you need for the installation (see Required Documentation [page 26]).

Installation Preparations

If you want to install multiple TREX instances, read section Information on Installing Multiple TREX Instan-
ces [page 35].

Download and extract the required software (see Downloading the Required Software [page 287) .

If you want to install TREX on Windows, ensure that you have the required authorization for running the in-
staller (see Windows: Required User Authorization for Running the Installer [page 29]).

Check whether there is sufficient disk space for installing the TREX software (see Checking Disk Space
[page 35]).

Installation

Install TREX (see Running the Installer [page 37]).

Post-Installation Activities

Configure TREX for the System Landscape Directory (SLD) (see Configuring TREX for the System Land-
scape Directory (SLD) [page 74]).

General UNIX Configuration

Check the UNIX kernel parameters and change them if necessary (see Checking and Changing UNIX Kernel
Parameters [page 78]).

TREX starts automatically if you have restarted the host.

If you have not restarted the host, start TREX manually (see Starting and Stopping TREX [page 104]).

General Windows Configuration

On Windows no actions are needed to start TREX. The SAP service for the corresponding TREX instance is
registered as a Windows service and starts automatically after installation.

Client Side

Configuration

Enter the address of the TREX name server in the Java client configuration settings (TREX service in J2EE)
(see Specifying the Address of the TREX Name Server [page 89]).

Check the proxy settings (see Checking Proxy Settings [page 90]).

SAP NetWeaver Standalone Engine Search and Classification TREX 7.0 - Single Host
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6.2 Installation with RFC Connection

Server Side

Installation Planning

Action

Check hardware and software requirements (see Hardware and Software Requirements [page 21])

Check what documentation you need for the installation (see Required Documentation [page 26]).

Installation Preparations

Action

If you want to install multiple TREX instances, read section Information on Installing Multiple TREX Instan-
ces [page 35].

Download and extract the required software (see Downloading the Required Software [page 287) .

If you want to install TREX on Windows, ensure that you have the required authorization for running the
installer (see Windows: Required User Authorization for Running the Installer [page 297)

Check whether there is sufficient disk space for installing the TREX software (see Checking Disk Space
[page 35])

Installation

‘ Install TREX (see Running the Installer [page 37]).

Post-Installation Activities

Action

Configure TREX for the System Landscape Directory (SLD) (see Configuring TREX for the System Land-
scape Directory (SLD) [page 74]).

General UNIX Configuration

Check the UNIX kernel parameters and change them if necessary (see Checking and Changing UNIX Kernel
Parameters [page 78]).

TREX starts automatically if you have restarted the host.

If you have not restarted the host, start TREX manually (see Starting and Stopping TREX [page 104]).

General Windows Configuration

On Windows no actions are needed to start TREX. The SAP service for the corresponding TREX instance is
registered as a Windows service and starts automatically after installation.
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Configuration of the RFC Connection

Define the SAP system user (see Creating a SAP System User for the TREX Admin Tool (Stand-Alone)
[page 84)).

Determine the connection data for the SAP system (see Determining the SAP System Connection Informa-
tion [page 85]).

Configure the RFC connection in the TREX admin tool (see Configuring the RFC Connection in the TREX
Admin Tool [page 86]).

Client Side

Configuration

On the client side, no further configuration steps are required.

6.3 Installation with HTTP and RFC Connections

Server Side

Installation Planning

Check hardware and software requirements (see Hardware and Software Requirements [page 21])

Check what documentation you need for the installation (see Required Documentation [page 26]).

Installation Preparations

If you want to install multiple TREX instances, read section Information on Installing Multiple TREX Instan-
ces [page 35].

Download and extract the required software (see Downloading the Required Software [page 28]) .

SAP NetWeaver Standalone Engine Search and Classification TREX 7.0 - Single Host
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If you want to install TREX on Windows, ensure that you have the required authorization for running the

installer (see Windows: Required User Authorization for Running the Installer [page 297)

Check whether there is sufficient disk space for installing the TREX software (see Checking Disk Space
[page 35])

Installation

‘ Install TREX (see Running the Installer [page 37]).

Post-Installation Activities

Configure TREX for the System Landscape Directory (SLD) (see Configuring TREX for the System Land-
scape Directory (SLD) [page 74]).

General UNIX Configuration

Check the UNIX kernel parameters and change them if necessary (see Checking and Changing UNIX Kernel
Parameters [page 78]).

TREX starts automatically if you have restarted the host.

If you have not restarted the host, start TREX manually (see Starting and Stopping TREX [page 104]).

General Windows Configuration

On Windows no actions are needed to start TREX. The SAP service for the corresponding TREX instance is
registered as a Windows service and starts automatically after installation.

Configuration of the RFC Connection

Define the SAP system user (see Creating a SAP System User for the TREX Admin Tool (Stand-Alone)
[page 84)).

Determine the connection data for the SAP system (see Determining the SAP System Connection Informa-
tion [page 857).

Configure the RFC connection in the TREX admin tool (see Configuring the RFC Connection in the TREX
Admin Tool [page 86]).

Client Side - ABAP Application

Configuration

On the client side, no further configuration steps are required.
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Client Side - Java Application

Configuration

Enter the address of the TREX name server in the Java client configuration settings (TREX
service in J2EE) (see Specifying the Address of the TREX Name Server [page 89]).

Check the proxy settings (see Checking Proxy Settings [page 9017).
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7 Installation Planning

The following sections contain information that is relevant when planning the installation.
Hardware and Software Requirements [page 21]

Required Documentation [page 26]

71 Hardware and Software Requirements

The tables below contain the hardware and software requirements for the TREX server software.

1 Note

The requirements for hardware and software listed here are valid for a TREX installation on a single host
(single-server system). The requirements for a distributed system that supports load balancing and high
availability are listed in the guide for the installation and configuration of a distributed TREX system. You can
find the Installation Guide — SAP NetWeaver 7.0 TREX Multiple Hosts at https://help.sap.com/viewer/p/
SAP_NetWeaver_TREX.
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Hardware Requirements

Requirement Type

Hard disk capacity

Requirement

The directories can be located on different partitions. The index directory and queue direc-
tory can also be located on a file server. The TREX host must be able to access the file server
as quickly as it can access the local hard drive.

Installer work directory
You require the following for software provisioning manager (“the installer” for short):
o OnUNIX, 200 MB in temporary directories or in a directory of your choice.
o On Windows, 200 MB in the directory C:\Program Files
SAP system directory
o OnUNIX, at least 1 GB in the directory /<sapmnt>/<sapsid>
o On Windows, at least 1 GB in the directory <disk drive>:\usr\sap\<SAPSID>
\SYS
TREX directory
You need the following for the TREX software:
o OnUNIX, at least 1 GB in the directory /usr/sap/<sapsid>/
trx<instance number>.
o On Windows, at least 1 GB in the directory <disk drive>:\usr\sap\<SAPSID>\
TRX<instance number>
You also need disk space in this directory for the trace files that TREX writes during rou-
tine operation.
Index directory
A minimum of 80 GB, depending on the number and type of documents to be indexed.
If documents exist in different formats (Microsoft Word, PDF, and so on), the index needs
approximately half as much disk space as the documents. For pure HTML documents,
the index needs about twice as much disk space as the documents. In addition, the same
amount of disk space as for the index is needed temporarily for the optimization proc-
ess.

Example

A document set that consists only of HTML documents and has a total size of 10 GB
generates an index size of 20 GB (2 x 10GB). An additional 20 GB disk space is
needed temporarily for optimization. Therefore, you need 40 GB disk space alto-
gether: 20 GB permanently and 20 GB temporarily.

Queue directory

The queues require approximately three quarters of the disk space required by the in-
dexes. The documents to be indexed are kept temporarily in the queue directory before
being forwarded to actually be indexed.

In the case of an installation with an RFC connection, you can use TREX with or without a
queue server. If you are not using a queue server, the queue directory is not relevant.
SAP Note 658052 contains information on which configuration is suitable for which ap-
plication.
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Requirement Type

’ Requirement

Demo or test system: At least 1 GB
Production system: 4 GB, at least 2 GB per CPU
With two index servers per TREX instance: At least 4 CPUs

i Note

The amount of main memory that is actually used depends on several factors. For exam-
ple, in the case of the index server, influencing factors are index size, number of parallel
search requests, and amount of the number of hits.

Windows: Software Requirements

Requirement Type

Requirement

Operating system

TREX (32 Bit binaries) supports the following Windows ver-

sions:
e Microsoft Windows Server 2003/1A32 32BIT (US Eng-
lish version) Service Pack 1 (SP1)
e Microsoft Windows Server 2003/X64 64BIT (US Eng-
lish version)

1 Note

Microsoft Windows Server 2003/X64 64BIT (US English
version) is supported with TREX 32 Bit binaries running
in compatibility mode.

1 Note

For security reasons, the supported partition installed on
Windows is NTFS (NT file system) not FAT32 (file alloca-
tion table).

For the most current information about platform and op-
erating system availability of TREX check the Platform
Availability Matrix (PAM) at:

https:/support.sap.com/pam

Python

Python 2.4.A Python version by ActiveState is part of the de-
livery. If Python has not been installed, it is installed by the
TREX setup program in the directory <TREX DIR>\exe
\Python.
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|
Requirement Type ’ Requirement

Web server Only relevant for an installation with an HTTP connection.

Microsoft Internet Information Server (l1IS) 5.0 or 6.0

Caution
Only IIS 6.0:

You have to ensure that the Internet Information Server
(I1S) is installed and that the Default Web Site is running.
To check this navigate to:

|} Control Panel > Administrative Tools > Computer
Management > Services and Application > Internet

Information Services (1IS) Manager }
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UNIX: Software Requirements

Requirement Type Requirement

Operating system

TREX (32 Bit binaries) supports one of the following UNIX versions:

e AIX
o AIX5.264Bit
o AIX5.364Bit
e HP-UX
o HP-UX11i (11.11) 64 Bit with patch PHSS_33263
o HP-UX11.23 64 Bit for PA-RISC with patch PHSS_34041
ORACLE SOLARIS
o ORACLE SOLARIS 9 64 Bit with patches 111711, 111712, and 112963
o ORACLE SOLARIS 10 64 Bit (no patches needed)
LINUX REDHAT
o LINUXRED HAT EL4/1A32 32BIT
o LINUX RED HAT EL4/X86_64 64BIT

1 Note

LINUX RED HAT EL4/ X86_64 64BIT is supported with TREX 32 Bit binaries
running in compatibility mode.

LINUX SUSE
o LINUX SUSE SLES9/1A32 32BIT Service Pack 1 (SP1)
o LINUX SUSE SLES9/ X86_64 64BIT Service Pack 1 (SP1)

1 Note

LINUX SUSE SLES9/ X86_64 64BIT is supported with TREX 32 Bit binaries run-
ning in compatibility mode.

Caution
TREX only supports LINUX distributions that have been released by SAP.

For the most current information about platform and operating system availabil-
ity of TREX check the Platform Availability Matrix (PAM) at: https://

support.sap.com/pam
Python Python 2.4.A Python version from ActiveState is part of the delivery and is installed by
the TREX setup program in the <TREX DIR>/exe/Python directory.
Web server

Only relevant for an installation with an HTTP connection.

Apache Web Server 1.3.29: The Web server is part of the delivery, and is installed by the
TREX setup program in the <TREX DIR>/Apache directory.
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7.2

Required Documentation

You require this installation guide and the following additional documentation for the installation:

e SAP Notes oninstallation
® Online information from SAP

SAP Notes on Installation

You must read the SAP Notes on installation before you begin the installation. The SAP Notes contain current

installation information and corrections to the installation documentation.

Make sure that you use the current version of these SAP Notes. .

Relevant SAP Notes
SAP Note Number ’ Title ’ Comments
1680045 M Release Note for Software Provisioning | Latest information on software provi-
Manager 1.0 sioning manager 1.0, supported SAP
products, and current restrictions
843360 Installing TREX 7.0 Contains information for all TREX 7.1 in-
stallations
892474 Pk TREX 7.0: RFC errors reported by TREX | Contains information about correct us-
admin tool (stand alone) ing of TREX admin tool (stand alone)
898401 TREX 7.0: Addressing 3GB Working Contains information on how to enable
Memory under Windows 3 GB working memory under Windows
917389 TREX 7.0: TREX application pool in IS Contains information about starting the
not started TREX application pool manually when
the Internet Information Server (lIS)
(Windows) is used as TREX Web Server

Online Information from SAP

Information on the following areas is available:

General Quick Links
Description

The SAP NetWeaver 7.0 Search and
Classification (TREX) Multiple Hosts in-
stallation guide

’ Internet Address

https://help.sap.com/viewer/p/
SAP_NetWeaver_TREX

’ Title

SAP Notes

https://support.sap.com/notes

Released platforms

https://support.sap.com/pam Fir
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Description

System sizing

’ Internet Address

https://sap.com/sizing

’ Title

Quick Sizer tool

Front-end installation

https://support.sap.com/sltoolset P
|# ¥ Front End Installation 3

Front End Installation Guide

Security

https://sap.com/security #r
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8 Installation Preparations

The following sections describe the steps you carry out before the TREX installation.
Downloading the Required Software [page 28]
Windows: Required User Authorization for Running the Installer [page 29]
TREX Global File System and TREX Instances [page 31]
Checking Disk Space [page 35]

8.1 Downloading the Required Software

Prerequisites

Make sure the latest version of the SAPCAR archiving tool is available on each installation host.

You require the SAPCAR archiving tool to be able to unpack software component archives (* . SAR files) which
is the format of software lifecycle media and tools that you can download from the SAP software distribution
center.

If required, you can download the latest version of SAPCAR from: https://launchpad.support.sap.com/#/
softwarecenter# | » Support Packages and Patches » A — Z ¥ Index » S » SAPCAR 1.

For more information about SAPCAR, see SAP Note 212876

Context

This section describes how to download and unpack the software required for the installation:
e The software provisioning manager 1.0 archive containing the installer. You always have to download the
latest version of the software provisioning manager 1.0 archive (see also SAP Note 1680045#%).
e The TREX binaries
e SAP Kernel 7.20 for your operating system

1 Note

The signature of media is checked automatically by the installer during the Define Parameters phase while
processing the Media Browser screens. As of now the installer only accepts media whose signature has been
checked. See also the description of this new security feature in SAP Note 2393060+ .
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Procedure

1. Make the installer software available as follows:

a. Download the latest version of the Software Provisioning Manager 1.0 archive 70SWPM10SP<support

package number> <version number>.SAR from:

https://launchpad.support.sap.com/#/softwarecenter# | SUPPORT PACKAGES & PATCHES » By
Alphabetical Index (A-Z) # S » SOFTWARE PROVISIONING MANAGER 3

b. Use SAPCAR to Unpack the software provisioning manager archive to a local directory (<unpack
directoryl>) with the following command:

SAPCAR -xvf <download directory>/<path>/<Archive>.SAR -R <unpack directoryl>
2. Make the TREX binaries available as follows:

a. Download the latest version from:

https://launchpad.support.sap.com/#/softwarecenter# | » Installations & Upgrades j» By Category
» SAP NetWeaver and complementary products » SAP NetWeaver » SAP NetWeaver 7.0 <Release>
Installation » <0s> ¥ Database  NW 7.0 <Release> Search/Class (TREX 700) 3
b. Use SAPCAR to unpack the downloaded archive to a local directory (<unpack directory2>)using
the following command:
SAPCAR -xvf <download directory>/<path>/<Archive>.SAR -R <unpack directory2>
3. Make SAP Kernel 7.20 for your operating system available as follows:

a. Make SAP Kernel 7.20 for your operating system available as follows:

https://launchpad.support.sap.com/#/softwarecenter# | » Installations & Upgrades j By Category
» SAP NetWeaver and complementary products ¥ SAP NetWeaver » SAP NetWeaver 7.0 <Release>
Kernel for installation/SWPM » SAP KERNEL 7.20 <32/64-BIT/UNICODE> » Installation » <0S> 4

b. Use SAPCAR to unpack the downloaded archive to a local directory (<unpack directory3>)using
the following command:
SAPCAR -xvf <download directory>/<path>/<Archive>.SAR -R <unpack directory3>

8.2 Windows: Required User Authorization for Running the
Installer

Although the installer automatically grants the required rights to the user account used for the installation, you
have to check whether this account has the required authorization to perform the installation. The
authorization required depends on whether you intend to perform a domain or local installation. If necessary,
you have to ask the system administrator to grant the account the necessary authorization before you start the
installation. If you attempt the installation with an account that has not the required authorization, the
installation aborts.

This section informs you about the authorization required for a domain and a local installation.
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Caution

Do not use the user <sapsid>adm for running the installer.

Domain Installation

For a domain installation the account used for the installation needs to be a member of the local Administrators
and the domain Admins group of the domain involved. All machines in the system must belong to the same
domain. In a domain installation, the user information is stored centrally on the domain controller and can be
accessed by all hosts in the system.

If the SAP system is to be distributed across more than one machine, SAP strongly recommends you to
perform a domain installation to avoid authorization problems.

Caution

e |[fyou install a system distributed over several hosts as a local installation, this can lead to authorization
problems for the operating system users <sapsid>admand SAPService<SAPSID>. It can also lead to
problems with the transport directory, which is usually shared by several SAP systems. Therefore, SAP
does not support a local installation for a system distributed over several hosts and recommends you to
install a system distributed over several hosts as a domain installation.

If you still want to perform a local installation for a system distributed over several hosts, make sure that:

o You use the same password for the <sapsid>adm or the SAPService<SAPSID> user on all hosts.
The password for the <sapsid>adm and SAPService<SAPSID> user can differ.

o You use the same master password on all hosts.

o All hosts belong to the same Windows work group.

® |n a Microsoft failover cluster configuration, you always have to perform a domain installation.

e [For performance and security reasons, SAP does not support an SAP system installation on a domain
controller.

e |ffor any reason, the account used for the installation is not a member of the domain Admins group, you
can perform the installation with a domain user who is a member of the local Administrators group.
However, the domain administrator has to prepare the system appropriately for you.

For a domain installation, you need to:

1. Check that the account used for the installation is a member of the domain Admins group.

2. Ifrequired, obtain these rights by asking the system administrator to enter the account as a member of the
domain Admins group.
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8.3 TREX Global File System and TREX Instances

The TREX server software comprises two parts:

e TREX global file system
This is a directory structure, in which information about the TREX system instances is stored. For example,
this information is required by management tools to start the TREX system.

e |[nstallation files for the TREX instance
These are the TREX program files, configuration files, and so on.

The global file system must be highly available. All instances of a TREX system must have permanent access to
it. When installing TREX and planning a distributed TREX system, you must decide which host the global TREX
file system should be located on.

1 Note

For information about installation and configuration of a distributed TREX system, see the Installation Guide
— SAP NetWeaver 7.0 TREX Multiple Hosts at https://help.sap.com/viewer/p/SAP_NetWeaver_TREX .

TREX Instance and SAP System Profile Directories

During the installation of the global file system and TREX instances, the following directories are important:

e SAP system profile directory in the global file system:
© OnUNIX /<SAP System Mount Directory>/<sapsid>/profile
o On Windows <SAPGLOBALHOST>\sapmnt\<SAPSID>\SYS\profile
e |nstallation directory for the TREX instance:
© OnUNIX /usr/sap/<sapsid>/trx<instance number>

o0 OnWindows <disk_drive>:\usr\sap\<SAPSID>\TRX<instance number>

Installation Procedure

You distinguish between the following scenarios when installing the global file system and the TREX instance:

e |nstalling a TREX Global File System with a First TREX Instance [page 32]
e |nstalling a TREX Instance Only [page 33]
e |[nstalling a TREX Global File System Only [page 34]
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8.3.1 Installing a TREX Global File System with a First TREX
Instance

In this scenario, you install a TREX global file system with a first TREX instance, which consists of the
installation of a TREX instance together with a TREX global file system on a local host. Basic information about
a TREX landscape is stored in the directory for the SAP system profiles for the global file system. If you set up a
new TREX system for a production scenario or if you are installing TREX for the first time, you always start with
the installation of a TREX global file system together with a first TREX instance. In a distributed landscape with
decentralized data storage and more than one TREX instance, you must install the TREX global file system with
a first TREX instance on the same host as the TREX master name server. TREX is then administrated, started,
and stopped from this host.

1 Note

More information about configuring a distributed TREX system, see thelnstallation Guide — SAP NetWeaver
7.0 TREX Multiple Hosts at https://help.sap.com/viewer/p/SAP_NetWeaver_TREX .

Directory structure and files

If you install the TREX global file system and the first TREX instance on a single host, a directory structure and
SAP system profiles are created on Windows as shown in the graphic below:

Folder Structure on TREX Single Host
(TREX Global File and First TREX Instance)

usr\sap\<SAPSID>\
--_SYS\

sarsssmssssEssnmma

i.... profile\
— DEFAULT.PFL
— START_TRX<instance_number>_<host>
— <SAPSID>_TRX<instance_number>_<host>

SEssEsEs s s e

. TRX<instance_number>\ —~~

.. exe\python_support\

> <TREX_DIR>
i.... <trex_hostname=\

i....index\
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8.3.2 Installing a TREX Instance Only

In this scenario, you install a TREX instance only. A TREX instance consists of a TREX instance without a TREX
global file system on the local host. You install a TREX instance to add one or more TREX instances to an
existing TREX system landscape. During installation, you must specify the path to the directory for the SAP
system profiles for the TREX global file system. In the default scenario, the TREX global file system and the
directory for the SAP system profiles are located on the same host.

In this case, the TREX global file system together with the first TREX instance on the one hand and the newly-
installed TREX instance on the other hand form a unit from an administration perspective. This is visible in that
they both have the same system ID (<sAPSID>) and use the same TREX global file system.

Directory structure and files

If you install an additionally TREX instance and connect it to an existing TREX global file system with a first
TREX instance, there are directory structures on Windows as illustrated in the graphic below:

TREXInstance # 1

|
TREX Global File System usr\sap\<SAPSID>\
and First TREXInstance .

i... TRX<instance_number>\
usr/sap/<SAPSID>/ +-exelpython_support/
E...SYSI .."' i....<trex_hostname>/

» .. index/
_:' i... queue/
|
....... profile/ .,
..... TRX<instance_number>/ Tl
TREX Instance # 2
i.... exe/python_support/ e n
e *, |_]/ usr\sap\<SAPSID>\
: _index/ .| i TRX<instance_number>\
i..queue/ .. ..... exelpython_support/
<trex_hostname>/
:..index/
i...queue;‘
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8.3.3 Installing a TREX Global File System Only

In this scenario, you install a TREX global file system only, without a TREX instance on you local host. You can
install the TREX global file system on any host, as long as you ensure that the TREX global file system is highly
available and accessible for all TREX instances at all times.

Directory structure and files

If you install only a TREX global file system on a host, the installation creates directory structures on Windows
as illustrated in the graphic below:

&0 Folder Structure on TREX Global File system

usr/sap/<SAPSID>/

- profile/
— DEFAULT.PFL

— START_TRX<instance_number>_<host>
— <SAPSID>_TRX<instance_number>_<host>

8.3.4 SAP System Profiles for the TREX Global File System

During installation of a TREX dialog instance, you specify the central directory for the SAP system profiles. In
this directory, the system automatically generates start profiles and instance profiles for the TREX instances
installed. System profiles contain information about the configuration of individual SAP instances. A start
profile determines which processes are to be started or stopped. (See Starting and Stopping TREX [page 1047])

Depending on the entries made during installation, the system creates the following profiles:

e System profile DEFAULT . PFL
The system profile contains settings and information that are important throughout the system. The
system profile exists once only in the global file system.
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e Start profile START TRX<instance number> <host>
This is the start profile for a TREX instance. It specifies the TREX instance number and the host name on
which the TREX instance runs.

® |Instance profile <SAPSID> TRX<instance number> <host>
The instance profile contains specific information about the runtime environment for a TREX instance.

8.3.5 Information on Installing Multiple TREX Instances

You can install several independent TREX instances on the same host. This is useful for test purposes. Note the
following:

During the setup

e Give each instance a different instance number.

® [Eachinstance must be installed in its own directory. The TREX setup program ensures this by including the
instance number in the directory name.

e FEachinstance must use a different port. The TREX setup program suggests suitable ports so that they do
not clash with other TREX instances on the same host.

After the installation (HTTP connection)

If you are installing TREX on Windows, you must make sure that the Web pages of the individual instances run
independently of one another. The following configuration is required for this:

e Microsoft IS 5.x: For each Web site, the Application Protection must be set to High (Isolated) in the
corresponding virtual directory.

e Microsoft IS 6.0: There must be a separate Web service extension for each instance. Each TREX Web site
must also use its own application pool.

The configuration steps are described in this guide.

8.4 Checking Disk Space

The installer creates the installation directory for the TREX software in the following directory:
® Windows: <disk drive>:\usr\sap\<SAPSID>

e UNIX: /usr/sap/<sapsid>

Before the installation starts, make sure that there is enough disk space in this directory for the TREX software.
For information on the required disk space, see Hardware and Software Requirements [page 21] .
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Procedure on UNIX

Starting Point Procedure

The directory /usr does not yet exist. For the directory /usr , select a partition that has sufficient
disk space for the TREX software and other SAP software if
necessary.

The directory /usr exists, but the directory /usr/sap does
not.

Choose one of the following options:

e Create a new partition with sufficient disk space for the
directory sap. Insert the directory sap into the direc-
tory /usr.

e (Create the directory sap in a file system that has suffi-
cient disk space. Generate a symbolic link to the direc-
tory sap in the directory /usr.

The directory /usr/sap already exists. Go to the directory /usr/sap and check the amount of free

disk space by executing the following command:
df -k
If there is not enough disk space, proceed as follows:

1. Create the installation directory in a file system that has
sufficient disk space. You must assign the installation
directory the name trx<instance number> .
<instance_ number>must match the instance num-
ber that you specified during the installation.

2. Generate a symbolic link to the installation directory in
the directory /usr/sap.

Procedure on Windows

On Windows you can choose the target drive during the installation. Use the Windows Explorer to check
whether there is sufficient disk space on the target drive.
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9 Installation

The sections that follow describe how to install TREX with the installer and tell you which entries are required
during the setup.

Running the Installer [page 37]

Installing TREX with a Virtual Host Name [page 46]

Installing a TREX Global File System with a First TREX Instance [page 50]
Installing a TREX Instance Only [page 59]

Installing a TREX Global File System [page 68]

9.1 Running the Installer

The following sections tell you how to run software provisioning manger 1.0 (“the installer” for short) to install
TREX on the released platforms.

Processing

You can now start the installation:

Useful Information about the Installer [page 37]

Running the Installer on UNIX [page 39]

Running the Installer on Windows [page 44]

9.1.1 Useful Information about the Installer

e The SL Common GUI of the Software Provisioning Manager (or “SL Common GUI" for short) uses the SAP
Ul Development Toolkit for HTML5 - also known as SAPUI5 - a client-side HTML5 rendering library based
on JavaScript. The benefits of this new user interface technology for the user are:

o Zero foot print, since only a web browser is required on the client
o New controls and functionality, for example, view logs in web browser.
The SL Common GUI connects the web browser on a client with the sapinst executable - which is part of
Software Provisioning Manager - running on the installation host using the standard protocol HTTPS.
o Windows only: For the SL Common GUI, the installer provides a pre-generated URL in the Program
Starter window. If you have a supported web browser installed on the host where you run the installer,
the SL Common GUI starts automatically. By default, the SL Common GUI uses the default browser
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defined for the host where you run the installer. However, you can also specify another supported web
browser available on the host where you start the installer. You can do this by starting the sapinst
executable with command line option SAPINST BROWSER=<Path to Browser Executable>, for
example SAPINST BROWSER=firefox.exe. Alternatively you can open a supported web browser on
any device and run the URL from there.

o UNIX only: For the SL Common GUI the installer provides a pre-generated URL at the bottom of the
shell from which you are running the installer . If you have a supported web browser installed on the
host where you run the installer, you can start the SL Common GUI directly from this URL. Otherwise,
open a web browser supported by the SL Common GUI on any device and run the URL from there.

o For more information about supported web browsers see the Prerequisites section in Procedure on
UNIX [page 48] or Procedure on Windows [page 48] .

As soon as you have started the sapinst executable, the installer creates a . sapinst directory
underneath the <Drive>:\Users\<User> directory where it keeps its log files. <User> is the user with
which you have started the installer.

After you have reached the Welcome screen and selected the relevant installer option, the installer creates
adirectory sapinst_instdir, where it keeps its log files, and which is located directly in the
$ProgramFiles% directory. After you have reached the Welcome screen and selected the relevant
installer option, the installer creates a directory sapinst_instdir where it keeps its log files. All log files
which have been stored so far in the . sapinst folder are moved to the sapinst instdir directory as
soon as the latter has been created.

Windows only: If the installer is not able to create sapinst instdir there, it tries to create
sapinst_instdir inthe directory defined by the TEMP environment variable.

UNIX only: The sapinst instdir directory is located directly below the temporary directory. The
installer finds the temporary directory by checking the value of the TEMP, TMP, or TMPDIR environment
variable. If no value is set for these variables, the installer uses /tmp by default. If you want the
sapinst_instdir directory to be created in another directory than /tmp, set the environment variable
TEMP, TMP, or TMPDIR to this directory before you start the installer.

Shell Used Command
Bourne shell (sh) TEMP=<Directory>
export TEMP
C shell (csh) setenv TEMP <Directory>
Korn shell (ksh) export TEMP=<Directory>

= Recommendation

We recommend that you keep all installation directories until the system is completely and correctly
installed.

The installer extracts itself to the temporary directory. These executables are deleted again after the
installer has stopped running.

Directories called sapinst exe.xxxxxx.xxxx sometimes remain in the temporary directory. You can
safely delete them.
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The temporary directory also contains the log file dev_selfex.out from the extraction process, which
might be useful if an error occurs.

Caution

If the installer cannot find a temporary directory, the installation terminates with the error FC0-00058 .

® Proceed as follows to see a list of all available installer properties:
o Windows: Go to the directory $TEMP%\sapinst exe.xxxxxx.xxxx after you have started the
installer, and enter the following command: sapinst.exe -p
o UNIX: Start the installer with the option-p: . /sapinst -p

e |fyou need to run SL Common GUI in accessibility mode, apply the standard accessibility functions of
your web browser.

e |f you want to install an SAP system in unattended mode, see SAP Note 950619#% .
e |[frequired, stop the installer by choosing the Cancel button.

1 Note

UNIX: If you need to terminate the installer, press +[c]

Windows: If you need to terminate the installer, choose ||+ File » Exit 3 in the menu of the Program
Starter window.

9.1.2 Running the Installer on UNIX

Prerequisites

e |f you want to use the SL Common GUI, make sure that the following web browser requirements are met:

o You have one of the following supported browsers on the device where you want to run the SL
Common GUI: Google Chrome, Mozilla Firefox, Microsoft Edge, or Microsoft Internet Explorer 11.
Always use the latest version of these web browsers.

= Recommendation

We recommend using Google Chrome.

o If you copy the SL Common GUI URL manually in the browser window, make sure that you open a new
Web browser window in private browsing mode (Internet Explorer), incognito mode (Chrome) or
private browsing mode (Firefox). This is to prevent Web browser plugins and settings from interfering
with the SL Common GUI.

For more information about the SL Common GUI, see Useful Information about the Installer [page 37].
® You have downloaded the required software as described in Downloading the Required Software [page 28]
e \We recommend that you use the csh shell for the installation with the installer. If you want to use another
shell, make sure that you have read SAP Note 202227 #r .
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e The installer uses csh scripts during the installation to obtain the environment for user <sapsid>adm.
This is also true if user <sapsid>adm already exists from an earlier SAP system installation, and the shell
of this user is not csh. Before you start the installer, execute the following command as user <sapsid>adm
to make sure that the csh scripts are up-to-date:

/bin/csh -c "source /<home>/<sapsid>adm/.cshrc;env"

e Make sure that your operating system does not delete the contents of the temporary directory /tmp or the
contents of the directories to which the variables TEMP , TMP , or TMPDIR point, for example by using a
crontab entry.

e Make sure that the temporary directory has the permissions 777.

e Make sure that you have at least 300 MB of free space in the installation directory for each installation
option. In addition, you need 300 MB free space for the installer executables. If you cannot provide 300 MB
free space in the temporary directory, you can set one of the environment variables TEMP , TMP , or TMPDIR
to another directory with 300 MB free space for the installer executables.

You can set values for the TEMP , TMP , or TMPDIR environment variable to an alternative installation
directory as described above in section Useful Information about the Installer [page 37]

e Make sure that your DISPLAY environment variable is set to <host_name>:0.0 , where <host_name> is the
host on which you want to display the installer GUI.

You can set values for the DISPLAY environment variables as follows:

Shell Used Command
Bourne shell (sh) DISPLAY=<host_ name>:0.0
export DISPLAY
C shell (csh) setenv DISPLAY <host_name>:0.0
Korn shell (ksh) export DISPLAY=<host name>:0.0

e Make sure that umask is set to 022 for user root. As user root, enter the following command: umask 022
e Make sure that you have checked the following values for user root:

o Incsh, execute 1imit.

Output ’ Properties

cputime unlimited
filesize unlimited
datasize unlimited
stacksize 8192 kb
coredumpsize unlimited
descriptors 8192
memorysize unlimited

o Inshorkshexecuteulimit -a.

Properties

time(seconds) unlimited
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Output ’ Properties

file(blocks) unlimited
data(kbytes) unlimited
stack(kbytes) 8192
coredump(blocks) unlimited
nofiles(descriptors) 8192
memory(KBytes) unlimited

o If your parameter settings differ from the settings above, change these values accordingly.

Example

If you have to change the value for descriptors to 8192, proceed as follows:
o Incshexecute: limit descriptors 8192
o Inshorkshexecute:ulimit -n 8192

e |f you want to install an additional application server instance in an existing SAP system, make sure that:
o Thereis exactly one entry inthe /usr/sap/sapservices file for each SAP instance installed on this
host. Be sure to check that the entry refers to the correct profile.

o There are no profile backup files with an underscore “_" in their profile name. If so, replace the “_" with
a“.

Example

Rename /usr/sap/S14/SYS/profile/S14 DVEBMGS20 zsi-aix693p2 D20081204
to /usr/sap/S14/SYS/profile/S14 DVEBMGS20 zsi-aix693p2.D20081204

e Make sure that the following ports are not used by other processes:

o Port 4237 is used by default as HTTPS port for communication between the installer and the SL
Common GUI.
If this port cannot be used, you can assign a free port number by executing the sapinst executable
with the following command line parameter:
SAPINST HTTPS_ PORT=<Free Port Number>

o Port 4239 is used by default for displaying the feedback evaluation form at the end of the installer
processing.
The filled-out evaluation form is then sent to SAP using HTTPS.
If this port cannot be used, you can assign a free port number by executing the sapinst executable
with the following command line parameter:
SAPINST HTTP PORT=<Free Port Number>

Context

If errors occur during the installation, see Troubleshooting with the Installer [page 101].
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Procedure

1. Log on to the installation host as a user with root authorizations

Caution

Make sure that the root user has not set any environment variables for a different SAP system or
database.

SL Common GUI only: If your security policy requires that the person running the installer is not allowed to
know the credentials of a user with root permissions on the installation host, you can specify another
operating system user for authentication purposes. You do this using the
SAPINST REMOTE ACCESS USER parameter when starting the sapinst executable from the command
line. You have to confirm that the user is a trusted one. For more information, see SAP Note 1745524 #% .

2. Start the installer from the directory to which you unpacked the 70SWPM10SP<support package

number> <version number>.SAR file by executing the following command: /<path to unpack
directory>/sapinst

Caution

Make sure that the installation directory is not mounted with NFS, otherwise there might be problems
when the Java Virtual Machine is started.

3. Theinstaller is starting up.

You can find the URL you require to access the SL Common GUI at the bottom of the shell from which you
are running the installer.

KA AR AR AR R A A A AR A A A A A A A R A AR A A A A AR AR A AR A AR AR A AR A A A AR AR A AR A AR AR A AR A AR AR AR A AR A A Ak kK

* %

Open your browser and paste the following URL address to access the GUI
https://[<hostname>] :4237/sapinst/docs/index.html

Logon users: [<users>]
dhkhkhkhkhkhkhhkhkh kb hkhhkhkr kb kb bk kb hk kb bk bk bk hkr kb kbbb rhkh bk bk hkrhkhkhkhhk kb hkrhkhkhkhkhkhkhkrkhkhkkkkxk

* %

If you have a supported web browser installed on the host where you run the installer, you can open this
URL directly in the shell. Otherwise open the URL in a supported web browser that runs on another device.

The SL Common GUI opens in the browser by displaying the Welcome screen.

1 Note

Before you reach the Welcome screen, your browser might warn you that the certificate of the sapinst
process on this computer could not be verified. Accept this warning to inform your browser that it can
trust this site, even if the certificate could not be verified.

4. Inthe Welcome screen choose |» Generic Installation Options » Search and Classification (TREX)

5. Follow the instructions in the input dialogs of the installer and enter the required parameters.
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The required input parameters are listed in the following sections:

o Installing a TREX Global File System with a First TREX Instance [page 50]
o Installing a TREX Instance Only [page 59]
o Installing a TREX Global File System [page 68]

1 Note

To find more information on each parameter during the Define Parameters phase, position the cursor on
the required parameter input field , and choose eitheror the HELP tab. Then the available help text
is displayed in the HELP tab.

Caution

The signature of media is checked automatically during the Define Parameters phase while processing
the Media Browser screens.

Keep in mind that this automatic check is only committed once and not repeated if you modify artefacts
such as SAR archives or files on the media after the initial check has been done. This means that - if you
modify artefacts later on either during the remaining Define Parameters phase or later on during the
Execute Service phase - the signature is not checked again.

See also the description of this new security feature in SAP Note 2393060 # .

6. After you have entered all input parameters, the installer starts the installation and displays the installation
progress during the processing phase.

If the installation was successful, the screen Execution of <option> has completed is displayed.

7. For security reasons, we recommend that you delete the . sapinst directory within the home directory of
the user with which you ran the installer:

<User Home>/.sapinst/

8. For security reasons, we recommend that you remove the operating system users from the group sapinst
after you have completed the installation.
1 Note

This step is only required, if you did not specify during the Define Parameters phase that the operating
system users are to be removed from the group sapinst after the execution of the installer has
completed.

Next Steps

If you have copied the installer software to your hard disk, you can delete these files when the installation has
successfully completed.
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9.1.3 Running the Installer on Windows

Prerequisites

e Forthe SL Common GUI, make sure that the following web browser requirements are met:
o You have one of the following supported browsers on the device where you want to run the SL
Common GUI: Google Chrome, Mozilla Firefox, Microsoft Edge, or Microsoft Internet Explorer 11.
Always use the latest version of these web browsers.

= Recommendation

We recommend using Google Chrome.

o If you copy the SL Common GUI URL manually in the browser window, make sure that you open a new
Web browser window in private browsing mode (Internet Explorer), incognito mode (Chrome) or
private browsing mode (Firefox). This is to prevent Web browser plugins and settings from interfering
with the SL Common GUI.

For more information about the SL Common GUI, see Useful Information about the Installer [page 37].

® You are logged on as user with the required rights and privileges that authorize you to run the installer. For
more information, see Windows: Required User Authorization for Running the Installer [page 29] .

® You have downloaded the required software as described in Downloading the Required Software [page 28]

® You need at least 300 MB of free space in the installation directory for each installation option. In addition,
you need 300 MB free space for the installer executables.

e |f you want to install an additional application server instance in an existing SAP system, make sure that:

o The service definitions for the SAP start services are configured correctly and refer to the correct
profile files.

o  There are no profile backup files with an underscore “_" in their profile name. If so, replace the “_" with
a“’

Example

Rename <Drive: >\usr\sap\S14\SYS\profile\S14_DVEBMGS20_wsi6408_12 to <Drive:>\usr
\sap\S14\SYS\profile\S14_DVEBMGS20_wsi6408.12.

e Make sure that the following ports are not used by other processes:

o Port 4237 is used by default as HTTPS port for communication between the installer and the SL
Common GUL.
If this port cannot be used, you can assign a free port number by executing the sapinst executable
with the following command line parameter:
SAPINST HTTPS_ PORT=<Free Port Number>

o Port 4239 is used by default for displaying the feedback evaluation form at the end of the installer
processing.
The filled-out evaluation form is then sent to SAP using HTTPS.
If this port cannot be used, you can assign a free port number by executing the sapinst executable
with the following command line parameter:
SAPINST HTTP_PORT=<Free Port Number>
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Context

If errors occur during the installation, see Troubleshooting with the Installer [page 101].

Procedure

1. Logonto theinstallation host as a user with administrator rights.

SL Common GUI only: If your security policy requires that the person running the installer is not allowed to
know administrator credentials on the installation host, you can specify another operating system user for
authentication purposes. You do this using the SAPINST REMOTE_ ACCESS_USER parameter when starting
sapinst.exe from the command line. You have to confirm that the user is a trusted one. For more
information, see SAP Note 1745524 # .

2. Start the installer by double-clicking sapinst.exe from the directory to which you unpacked the

70SWPM10SP<support package number> <version number>.SAR file.

3. Theinstaller is starting up.

The installer now starts and waits for the connection with the SL Common GUI. If you have a supported
web browser installed on the host where you run the installer, the SL Common GUI starts automatically by
displaying the Welcome screen.

If the SL Common GUI does not open automatically, you can find the URL you require to access the SL
Common GUI at the bottom of the Program Starter window of the installer. You find the icon of the Program
Starter window in the taskbar of your Windows host. Open a supported web browser and run the URL from
there.

ok rxhkhkhkhhkhkhkhhhkhkhhkrhkhkhhhkhhkhhhk bk hhkrhhkhkhh bk hhkrhhkhkhhkhhkhkhhhkhhkrhhkhkhhkrkhkhhkrhkhkrhkkrkhkhkxkxkkx
* %

Open your browser and paste the following URL address to access the GUI
https://[<hostname>]:4237/sapinst/docs/index.html

Logon users: [<users>]
R R I R i I e S S R I I S b I S I S I S b I S S R I S S b b b I S b b S b S IR S b I b S I I S b S b i

* K

The SL Common GUI opens in the browser by displaying the Welcome screen.

1 Note

Before you reach the Welcome screen, your browser might warn you that the certificate of the sapinst
process on this computer could not be verified. Accept this warning to inform your browser that it can
trust this site, even if the certificate could not be verified.

4. Inthe Welcome screen choose | Generic Installation Options ¥ Search and Classification (TREX) 3.
If the installer prompts you to log off from your system, log off and log on again.

5. Follow the instructions in the input dialogs of the installer and enter the required parameters.

The required input parameters are listed in the following sections:

o Installing a TREX Global File System with a First TREX Instance [page 50]
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o Installing a TREX Instance Only [page 59]
o Installing a TREX Global File System [page 68]

1 Note

To find more information on each parameter during the Define Parameters phase, position the cursor on

the required parameter input field , and choose either or the HELP tab. Then the available help text
is displayed in the HELP tab.

Caution

The signature of media is checked automatically during the Define Parameters phase while processing
the Media Browser screens.

Keep in mind that this automatic check is only committed once and not repeated if you modify artefacts
such as SAR archives or files on the media after the initial check has been done. This means that - if you
modify artefacts later on either during the remaining Define Parameters phase or later on during the
Execute Service phase - the signature is not checked again.

See also the description of this new security feature in SAP Note 23930607 .

6. After you have entered all input parameters, the installer starts the installation and displays the installation

progress during the processing phase.
If the installation was successful, the screen Execution of <option> has completed is displayed.

For security reasons, we recommend that you delete the . sapinst directory within the home directory of
the user with which you ran the installer:

$userprofile%\.sapinst\

Next Steps

If you have copied the installer software to your hard disk, you can delete these files when the installation has
successfully completed.

9.2

Installing TREX with a Virtual Host Name

To make your TREX installation accessible by a virtual host name you change the host name of the host on
which you intend to install TREX. You do this by executing the following steps:

46

Change the host name to the virtual host name

Before you install TREX you change the name of the installation host to a virtual host name on operating
system level.

Install TREX and change the host name back

After you have installed TREX on the installation host you change the host name back to the original host
name.
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e (Change the TREX Settings
To make the virtual host name work for your TREX installation you need to change some TREX settings.

Prerequisites

The virtual host name must be valid at the operating system level and in the network the host is a part of. It can
be a new primary host name, an additional alias name, or it's IP address. The host must be accessible with this
name using the ping command. Only then TREX can monitor itself and can be used by other applications.

Related Information

Changing the Host Name to the Virtual Host Name [page 47]
Installing TREX and Changing the Host Name Back [page 48]
Changing the TREX Settings [page 49]

9.2.1 Changing the Host Name to the Virtual Host Name

Context

Before you install TREX you change the host name of the host on which you intend to install TREX to a virtual
host name on operating system level.

Related Information

Procedure on UNIX [page 48]
Procedure on Windows [page 48]
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0.2.1.1 Procedure on UNIX

Procedure

1. Logontothe installation host as a user with root authorizations.

2. Change the host name of your installation host by the following command: hostname
<virtual_ hostname>

1 Note

The host name is usually set once at system startup by reading the contents of a file which contains the
host name, for example /etc/hostname .

9.2.1.2 Procedure on Windows

Procedure

—

Log on to the installation host as user with administrator rights.

Open |» Start » Control Panel » System 1.

On the Computer Name tab, choose Change .

A wn

In the Computer name field, type your new virtual host name <virtual hostname>.

1 Note

The name must be unique. You cannot use a name already in use on the network.

5. You need to restart your host for the new settings to take effect.

9.2.2 Installing TREX and Changing the Host Name Back

Context

After you have installed TREX on the installation host you change the host name back to the original host name.
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Procedure

1. Install TREX as described in Running the Installer [page 37].
2. Stop TREX if necessary (incl. sapstartsrv ) as described in Stopping TREX [page 109]

1 Note

As long as the host name is changed to the virtual host name do not start or stop any other TREX
instances. Otherwise those TREX instances would change the TREX configuration file toplogy.ini so that
the instances will be registered with the virtual host name there.

3. Change the virtual host name <virtual hostname> of your installation host back to the original host
name as described in Changing the Host Name to the Virtual Host Name [page 47].

9.2.3 Changing the TREX Settings

Context

To make the virtual host name work for your TREX installation you have to specify the following TREX settings.

Related Information

Procedure on UNIX [page 49]
Procedure on Windows [page 50]

9.2.3.1 Procedure on UNIX

Procedure

1. Create a file with the name hostname in the home directory of the <sapsid>adm user with the following
content:

#!/bin/sh

echo <virtual hostname>
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2. Make the file hostname executable by entering the following command:

chmod+x hostname

9.2.3.2 Procedure on Windows

Procedure

1. Change the TREX profile files START TRX<instance number> <virtual hostname>and sapprofile.ini
as follows:

Change TREX start profile START TRX<instance number> <virtual hostname>.You find the TREX
start profile in the global file system for your TREX installation TREX GLOBAL (/usr/sap/
<SAPSID>/SYS/profile).

2. Change the line SAPLOCALHOST=<virtual hostname>.Ifthereisaline
SAPGLOBALHOST=<o0ld hostname> then also change it.

o Change the configuration file <TREX DIR>/<virtual hostname>/sapprofile.ini.
o Change the line SAPLOCALHOST=<virtual hostname>.
If there is a line SAPGLOBALHOST=<o0ld_hostname> then also change it.

3. Start TREX as described inStarting TREX [page 106] .

9.3 Installing a TREX Global File System with a First TREX
Instance

The table below shows the names of the screens that are displayed during the installation of a TREX global file
system with first TREX instance and the entries that you need to make.
1 Note

For more information about the concept of the central TREX instance, see Installing a TREX Global File
System with a First TREX Instance [page 32].

1 Note

For more information about the input parameters, position the cursor on the parameter in the installer GUI

and press 1]
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After the installer has started, the Welcome screen appears:

Screen ‘ Input

Welcome

In the folder hierarchy, choose |} SAP NetWeaver 7.0 <Release> > Standalone Engines >
Search and Classification (TREX) > TREX Global File System with First TREX Instance }

Parameter Mode > Default
Settings

You can choose between Typical Mode or Custom Mode:

e Typical Mode
If you choose Typical, the option is performed with default settings. As a result, you
only have to respond to a small selection of prompts. If you want to change any of the
default settings, you can do so on the Parameter Summary screen. Note that if you
choose the Typical setting and then choose Back after processing one or more input
screens, the Custom setting is activated. You are now guided through all screens with
the default parameters that have been applied in the background so far .

e Custom Mode
If you choose Custom, you are prompted for all parameters. At the end, you can still
change any of these parameters on the Parameter Summary screen .

Media Browser > Software
Package Request

e Provide the path to the media with the TREX 7.0 installation files in Package Location.
® Provide the path to the media with the SAP NetWeaver Kernel 7.20 installation files in
Package Location.

Caution

During the TREX installation, which you perform as the root user (UNIX) or as a user
with administration rights (Windows), the operating system user <SAPSID>adm is cre-
ated. For all operating systems, make sure that the user <sApPSID>adm has at least
read-access to the TREX and the SAP NetWeaver Kernel installation software. Other-
wise, a Python error message can occur during installation.

If the <sAPSID>adm user does not have at least read-access for thefolder containing the
TREX installation files, you can copy the TREX binaries to your local hard-drive. To do this,
specify in CopyPackageTo the path to the directory to which you want to copy the files.

SAP System > DNS Domain
Name

DNS Domain Name for SAP System

FQDN is the fully qualified domain name for an IP address. It consists of the host name
and the domain name: <host name>.<domain name>

Enter the DNS domain name for the SAP system. The DNS domain name is appended to
the server name to calculate the FQDN.

The DNS Domain Name is used to calculate the Fully Qualified Domain Name (FQDN),
which is configured in profile parameter SAPLOCALHOSTFULL. This parameter is needed
to define the URLs for the ABAP and Java application servers. See SAP Note 654982 #r .

DNS has to be configured so that the FQDN can be resolved to an IP address .

1 Note

If your application server host is named kirk.wdf.sap.com, you have to enter
wdf.sap.com.
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Screen ‘ Input

SAP System > General SAP System ID (SAPSID)
Parameters
The SAP system ID <saPSID> is the identifier for the SAP system.
e |fyouinstall a new SAP system, enter the SAP system ID <saps1D> for this system.
e |fyou install the instances of this system on more than one host, make sure that you
assign the same <SAPSID> to all these instances.
e |fyou add instances to an existing SAP system - for example, if you install dialog in-
stances for an existing SAP system - enter the <SAPSTD> of the existing SAP system.
e |fyou uninstall an SAP system, enter the SAP system ID <saps1D> of the SAP system
you want to uninstall.
® (Choose your <saPsID> carefully. Renaming is complicated and requires you to re-in-
stall the SAP system.The ID must be unique throughout your organization and consis-
tent throughout your SAP system installation landscape.
e The ID must consist of exactly three alphanumeric characters.
®  Only uppercase letters are allowed .
® The first character must be a letter (not a digit).
e The following IDs are reserved and cannot be used: ADD ADM ALL AMD AND ANY
ARE ASC AUX AVG BIT CDC COM CON DBA END EPS FOR GET GID IBM INT KEY LOG
LPT MAP MAX MIN MON NIX NOT NUL OFF OLD OMS OUT PAD PRN RAW REF ROW
SAP SET SGA SHG SID SQL SUM SYS TMP TOP UID USE USR VAR.
Caution
When you choose a system ID <saps1D> for your TREX landscape, check which sys-
tem IDs are already in use by other SAP applications on the same host where TREX is
to be installed.
Do not use a system ID <sAPSID> that is already used for another SAP system land-
scape. Otherwise an error message will occur.
SAP System > General .
’ Caution
Parameters
This parameter is only required on Windows.
Installation Drive
This is the drive where the SAP base directory (\usr\sap ) isinstalled.
If saploc already exists, you cannot select the local drive.
Example
If you select D: , the directory \usr\sap is created on drive D.
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SAP System > General

Caution
Parameters

This parameter is only required on UNIX.

SAP System Mount Directory

The installer retrieves parameters from the SAP system profile directory of an existing
SAP system.

SAP profiles are operating system files that contain instance configuration information.

The installer prompts you to enter the location of the profile directory when the installation
option that you execute is not the first one belonging to your SAP system installation, for
example if you are installing a distributed system or a dialog instance to an existing SAP
system. See also the description of the parameters SAP System ID and Database ID.

/usr/sap/<SAPSID>/SYS/profileisthe softlink referring to /<sapmnt>/
<SAPSID>/profile

SAP System > Master
Passwords

Master Password
Common password for all users that are created during the installation.

We recommend that you use the same master password for each installation of a distrib-
uted scenario.

® Basic password policy:
The master password must meet the following requirements:
o It must be 8 to 14 characters long
o |t must contain at least one letter (a-z, A-Z)
o |t must contain at least one digit (0-9)
o It must not contain \ (backslash) and " (double quote).
e Additional restrictions depending on your operating system:
o Windows:

o If auser already exists, you are prompted to confirm the password for this
user.

o Depending on the configuration of the password policy, additional restric-
tions may apply.
e Other restrictions:
o Depending on the installation option, additional restrictions may apply (for ex-
ample, the master password must not contain the name of a Java user created
during the installation).
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SAP System > Windows
Domain

Caution

This screen and these parameters are only required on Windows

Domain Model

Choose whether you want to create the <sapsid>adm and SAPService <SAPSID>
users:

e Onthe local computer ( Local Installation ).

® |nthe domain of the user who is performing the installation (Use Domain for Current
User)

® |nadomain that is different from the domain of the user who is installing the SAP sys-
tem ( Use Different Domain )

If you want to use the domain of the current user, the <sapsid>admand SAPService
<SAPSID> users can only be created by the installer if the account used for the installation
has domain administrator rights in the domain involved. If not, a user with domain admin-
istrator rights has to create these users before the installation is started. For more infor-
mation, see the installation guide. If the account used is a local user, a local installation is
performed (on the local computer).

If you want to use a different domain, you have to specify the Windows domain.

The <sapsid>admand SAPService <SAPSID> users can only be created in the different
domain by the installer if the account used for the installation has domain administrator
rights in in the other domain. If not, a user with domain administrator rights for this do-
main has to create these users in this domain before the installation is started. For more
information, see the installation guide.

Only choose to create the users on the local computer, if you do not want to install:

e Several application servers (dialog instances) or SAP systems that are using a com-
mon transport directory.
If you choose this option, you can only access the SAP system from another com-
puter, if the same user with the same password exists on both computers and both
computers belong to the same domain or workgroup, or if you authenticate the ses-
sion with user name and password

e A high-availability system with Microsoft Cluster Service (MSCS)

SAP System > OS User
Passwords

Password of the SAP System Administrator user <sapsid>adm

e Password for the operating system user If the user already exists, enter the exact
password of this user .

e Otherwise choose a new password for this user. The installer then creates this user
with the new password

The password policy for creating a new password depends on the settings of your operat-
ing system.

Ask your system administrator if you are not sure about the policy.
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SAP System > OS User )
Passwords Caution
This parameter is only required on Windows.
Password of the SAP System Service user SAPService<SAPSID>
e Password for the operating system user If the user already exists, enter the exact
password of this user .
e Otherwise choose a new password for this user. The installer then creates this user
with the new password
The password policy for creating a new password depends on the settings of your operat-
ing system.
Ask your system administrator if you are not sure about the policy.
SAP System > OS User ]
Passwords Caution

These parameters are only required on UNIX.

User ID:

Enter the User ID for the user shown, making sure that the ID is unique.
If you do not enter a User ID, the installer assigns a free ID.

Login Shell:

If you use a login shell other than the recommended C shell (csh), see SAP Note 202227

#& for more information.
Home Directory:
The home directory for the specified user

Enter the home directory for the specified user. Make sure that you enter a home directory
that is not critical for recursive changes on permissions.

When operating system users are created by the installer, the permissions on the home
directories of these users are changed recursively. This can cause unpredictable errors if
you define a critical home directory.

Example

Do not enter / or /usr/sap as the home directory.
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TREX > Instance Instance Number
Technical identifier for internal processes. Consists of a two-digit number between 00 and
97.
Enter the instance number that you want to create for this specific instance.
Choose a new TREX instance to install or an existing TREX instance to upgrade.
e |f more than one SAP instance is running on the same host, you must assign these
instances different numbers
o AlX:
If you are using NIM Service Handler (NIMsH), do not use 01 or O2 for the instance
number. SAPinst uses the instance number for the internal message server port
39<instance number>.
e HP-UX:
Do not use the following numbers:
o 02 - used by the operating system
This number is used to determine the port number for report RSLGCOLL , which
is l4<instance number> by default. However, the port 1402 is already used by
the OS process rstlisten. If you decide to use 02 as the instance number anyway,
the instance fails to start during the installation process. You then have to change
the port number for report RSL.GCOLL manually to continue with the installation.
o 75 -used by the operating system
For more information, see SAP Note 29972 ¥
e \Windows:Do not use the following numbers:
o 43 - used by Microsoft Cluster Service (MSCS)
o 89 -used by Windows Terminal Server (WTS)
The installer checks whether the installation directory already exists. If not, it creates it.
The directory is:
e OnUNIX:
/usr/sap/<SAPSID>/trx<instance number>
e On Windows:
<disk drive>:\usr\sap\<SAPSID>\TRX<instance number>
The path to the directory is fixed and cannot be changed (apart from the Windows disk
drive).
Caution
The directory should not be available before the installation unless you explicitly cre-
ated it for space reasons previously (see Checking Disk Space [page 35] ).
This allows you to ensure that the directory does not contain any data that doesn't be-
long to TREX, which would then also be deleted if TREX were uninstalled.
SAP NetWeaver Standalone Engine Search and Classification TREX 7.0 - Single Host
56 CUSTOMER Installation


http://help.sap.com/disclaimer?site=https://launchpad.support.sap.com/#/notes/29972

|
Screen ‘ Input

TREX > Instance Details Install HTTP Server

If the application communicates with TREX using an HTTP connection, select this field.

Caution
Only Windows:
You have to ensure that the Internet Information Server (1IS) is installed and that the
Default Web Site isrunning. To check this navigate to: |} Control Panel >
Administrative Tools > Computer Management > Services and Application > Internet

Information Services (IIS) Manager }
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TREX > Proxy Settings

Enter the proxy configuration settings.
If there is a proxy server between the TREX servers and the documents to be indexed,
specify the proxy server and define exclusion rules if necessary.

Example

You want to index the following:

e Documents on internal servers that can be accessed without a proxy server

® \Web pages on external servers that can only be accessed using a proxy server
In this case, specify the proxy server. Define exclusion rules for company-internal ad-
dresses, because the proxy server should not be used for those addresses

® Proxy Server — host name and domain of the proxy server

Example

proxy.mylocation.mycompany.com

e Proxy Server Port — port of the proxy server

Example

8080

® Proxy User — user name needed to access the proxy server

e Proxy User Password — password defined for the user

® Proxy Exclusions — exclusion rules.
These rules define when TREX is not to use the proxy server. Use a semicolon to sepa-
rate multiple entries.

Example

Examples of exclusion rules:
o Do not use the proxy server to get URLs that end in
mycompany.com:mycompany.com .

o Do not use the proxy server to get IP addresses that start with 10.: 10.

Caution

Do not use asterisks as placeholders.
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TREX > Languages for
Document Analysis

TREX supports all main European and Asian languages for indexing and searching.

Only select the languages that are relevant. This optimizes performance during the lan-
guage recognition process and therefore during the search and indexing process. The lan-
guage recognition process gives better results if as few languages as possible are used.
You can also change settings for the language recognition after the installation.

If the application does not transmit the document language to TREX, TREX has to identify
the language before indexing. You can select the languages that you want TREX to recog-
nize.

Caution

Only select the languages that are relevant. This optimizes performance during the lan-
guage recognition process, and therefore during the search and indexing process. The
language recognition process gives better results if as few languages as possible are
used.

1 Note

However, TREX can also index documents whose language is not specified here. TREX
then inserts the documents in question into the index for the default language (nor-
mally English). For example, if you select English and German and a document in Span-
ish is then indexed, the document is inserted into the English index.

This affects the documents in question in the following manner:

® Alinguistic search is not possible.
e TREX may extract keywords (document features) that are not characteristic of the
document.

SAP System> SAP
Cryptographic Software

Path to SAPCRYPTO. SAR

TheSAP Cryptographic Library is required to enable Secure Sockets Layer (SSL) encryp-
tion of HTTP connections. If you do not have the required SAPCRYPTO . SAR archive avail-
able, you can download it as described in SAP Note 455033 #% .

If you want to use SSL, you have to enter the path to the location of SAPCRYPTO. SAR

for your platform.

9.4 Installing a TREX Instance Only

The table below shows the names of the screens that are displayed during the installation of a TREX instance
only and the entries that you need to make.
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For more information about the concept of the TREX dialog instance, see Installing a TREX Instance Only

1 Note
[page 33]
1 Note

For more information about the input parameters, position the cursor on the parameter in the installer GUI

and press [F1]

After the installer has started, the Welcome screen appears:

Screen Input

Welcome

In the folder hierarchy, choose |} SAP NetWeaver 7.0 <Release> > Standalone Engines >
Search and Classification (TREX) > TREX Global File System with First TREX Instance }

Parameter Mode > Default
Settings

You can choose between Typical Mode or Custom Mode:

Typical Mode

If you choose Typical, the option is performed with default settings. As a result, you
only have to respond to a small selection of prompts. If you want to change any of the
default settings, you can do so on the Parameter Summary screen. Note that if you
choose the Typical setting and then choose Back after processing one or more input
screens, the Custom setting is activated. You are now guided through all screens with
the default parameters that have been applied in the background so far .

Custom Mode

If you choose Custom, you are prompted for all parameters. At the end, you can still
change any of these parameters on the Parameter Summary screen .

Media Browser > Software
Package Request

During the TREX installation, which you perform as the root user (UNIX) or as a user
with administration rights (Windows), the operating system user <SAPSID>adm is cre-
ated. For all operating systems, make sure that the user <saps1D>adm has at least
read-access to the TREX and the SAP NetWeaver Kernel installation software. Other-
wise, a Python error message can occur during installation.

If the <saPSID>adm user does not have at least read-access for thefolder containing the
TREX installation files, you can copy the TREX binaries to your local hard-drive. To do this,
specify in CopyPackageTo the path to the directory to which you want to copy the files.

Provide the path to the media with the TREX 7.0 installation files in Package Location.

Provide the path to the media with the SAP NetWeaver Kernel 7.20 installation files in
Package Location.

Caution
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zAP System > DNS Domain DNS Domain Name for SAP System
ame

FQDN is the fully qualified domain name for an IP address. It consists of the host name
and the domain name: <host name>.<domain name>

Enter the DNS domain name for the SAP system. The DNS domain name is appended to
the server name to calculate the FQDN.

The DNS Domain Name is used to calculate the Fully Qualified Domain Name (FQDN),
which is configured in profile parameter SAPLOCALHOSTFULL. This parameter is needed
to define the URLs for the ABAP and Java application servers. See SAP Note 654982 Fi .

DNS has to be configured so that the FQDN can be resolved to an IP address .

1 Note

If your application server host is named kirk.wdf.sap.com, you have to enter
wdf . sap.com.

SAP System > General

Profile Directory
Parameters

The path to the directory in which the SAP system profiles are stored.

e Windows:
\\<SAPGLOBALHOST>\sapmnt\<SAPSID>\SYS\profile
e UNIX:
/<SAP System Mount Directory>/<SAPSID>/profile

In the default scenario, the SAP system profiles are located on the host on which the TREX
global file system with first TREX instance has been installed. You can choose Browse to
search for the directory.

1 Note

The global file system must be highly available. All instances of a TREX system must
have permanent access to it. You guarantee this by inserting the profile directory as a
network drive (Windows) or by mounting it (mount on UNIX).

SAP System > General

Caution
Parameters

This parameter is only required on Windows.
Installation Drive
This is the drive where the SAP base directory (\usr\sap ) is installed.

If saploc already exists, you cannot select the local drive.

Example

If you selectD: , the directory \usr\sap is created on drive D.
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SAP System > Master
Passwords

Master Password
Common password for all users that are created during the installation.

We recommend that you use the same master password for each installation of a distrib-
uted scenario.

® Basic password policy:
The master password must meet the following requirements:
o It must be 8 to 14 characters long
o |t must contain at least one letter (a-z, A-Z)
o It must contain at least one digit (0-9)
o |t must not contain \ (backslash) and " (double quote).
e Additional restrictions depending on your operating system:
o Windows:

o If auser already exists, you are prompted to confirm the password for this
user.

o Depending on the configuration of the password policy, additional restric-
tions may apply.
e Otherrestrictions:
o Depending on the installation option, additional restrictions may apply (for ex-
ample, the master password must not contain the name of a Java user created
during the installation).
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SAP System > Windows
Domain

Caution

This screen and these parameters are only required on Windows

Domain Model

Choose whether you want to create the <sapsid>adm and SAPService <SAPSID>
users:

e Onthe local computer ( Local Installation ).

® |nthe domain of the user who is performing the installation (Use Domain for Current
User)

® |nadomain that is different from the domain of the user who is installing the SAP sys-
tem ( Use Different Domain )

If you want to use the domain of the current user, the <sapsid>admand SAPService
<SAPSID> users can only be created by the installer if the account used for the installation
has domain administrator rights in the domain involved. If not, a user with domain admin-
istrator rights has to create these users before the installation is started. For more infor-
mation, see the installation guide. If the account used is a local user, a local installation is
performed (on the local computer).

If you want to use a different domain, you have to specify the Windows domain.

The <sapsid>admand SAPService <SAPSID> users can only be created in the different
domain by the installer if the account used for the installation has domain administrator
rights in in the other domain. If not, a user with domain administrator rights for this do-
main has to create these users in this domain before the installation is started. For more
information, see the installation guide.

Only choose to create the users on the local computer, if you do not want to install:

e Several application servers (dialog instances) or SAP systems that are using a com-
mon transport directory.
If you choose this option, you can only access the SAP system from another com-
puter, if the same user with the same password exists on both computers and both
computers belong to the same domain or workgroup, or if you authenticate the ses-
sion with user name and password

e A high-availability system with Microsoft Cluster Service (MSCS)

SAP System > OS User
Passwords

Password of the SAP System Administrator user <sapsid>adm

e Password for the operating system user If the user already exists, enter the exact
password of this user .

e Otherwise choose a new password for this user. The installer then creates this user
with the new password

The password policy for creating a new password depends on the settings of your operat-
ing system.

Ask your system administrator if you are not sure about the policy.

SAP NetWeaver Standalone Engine Search and Classification TREX 7.0 - Single Host

Installation

CUSTOMER 63



|
Screen ‘ Input

SAP System > OS User )
Passwords Caution
This parameter is only required on Windows.
Password of the SAP System Service user SAPService<SAPSID>
e Password for the operating system user If the user already exists, enter the exact
password of this user .
e Otherwise choose a new password for this user. The installer then creates this user
with the new password
The password policy for creating a new password depends on the settings of your operat-
ing system.
Ask your system administrator if you are not sure about the policy.
SAP System > OS User ]
Passwords Caution

These parameters are only required on UNIX.

User ID:

Enter the User ID for the user shown, making sure that the ID is unique.
If you do not enter a User ID, the installer assigns a free ID.

Login Shell:

If you use a login shell other than the recommended C shell (csh), see SAP Note 202227

#& for more information.
Home Directory:
The home directory for the specified user

Enter the home directory for the specified user. Make sure that you enter a home directory
that is not critical for recursive changes on permissions.

When operating system users are created by the installer, the permissions on the home
directories of these users are changed recursively. This can cause unpredictable errors if
you define a critical home directory.

Example

Do not enter / or /usr/sap as the home directory.
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TREX> Instance Instance Number

Technical identifier for internal processes. Consists of a two-digit number between 00 and
97.

Enter the instance number that you want to create for this specific instance.

Choose a new TREX instance to install or an existing TREX instance to upgrade.

e |f more than one SAP instance is running on the same host, you must assign these
instances different numbers

o AIX:
If you are using NIM Service Handler (NIMsH), do not use 01 or O2 for the instance
number. SAPinst uses the instance number for the internal message server port
39<instance number>.

o HP-UX:
Do not use the following numbers:

o 02 - used by the operating system
This number is used to determine the port number for report RSLGCOLL , which
is l4<instance number> by default. However, the port 1402 is already used by
the OS process rstlisten. If you decide to use 02 as the instance number anyway,
the instance fails to start during the installation process. You then have to change
the port number for report RSL.GCOLL manually to continue with the installation.
o 75 -used by the operating system
For more information, see SAP Note 29972 ¥

e \Windows:Do not use the following numbers:
o 43 - used by Microsoft Cluster Service (MSCS)
o 89 -used by Windows Terminal Server (WTS)

The installer checks whether the installation directory already exists. If not, it creates it.
The directory is:

e  OnUNIX:
/usr/sap/<SAPSID>/trx<instance number>

e  On Windows:
<disk drive>:\usr\sap\<SAPSID>\TRX<instance number>

The path to the directory is fixed and cannot be changed (apart from the Windows disk
drive).
Caution

The directory should not be available before the installation unless you explicitly cre-
ated it for space reasons previously (see Checking Disk Space [page 35] ).

This allows you to ensure that the directory does not contain any data that doesn't be-
long to TREX, which would then also be deleted if TREX were uninstalled.
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TREX > Instance Details Install HTTP Server

If the application communicates with TREX using an HTTP connection, select this field.

Caution

Only Windows:

You have to ensure that the Internet Information Server (1IS) is installed and that the
Default Web Site isrunning. To check this navigate to: |} Control Panel >
Administrative Tools > Computer Management > Services and Application > Internet

Information Services (1IS) Manager 4
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TREX > Proxy Settings

Enter the proxy configuration settings.
If there is a proxy server between the TREX servers and the documents to be indexed,
specify the proxy server and define exclusion rules if necessary.

Example

You want to index the following:

e Documents on internal servers that can be accessed without a proxy server

® \Web pages on external servers that can only be accessed using a proxy server
In this case, specify the proxy server. Define exclusion rules for company-internal ad-
dresses, because the proxy server should not be used for those addresses

® Proxy Server — host name and domain of the proxy server

Example

proxy.mylocation.mycompany.com

e Proxy Server Port — port of the proxy server

Example

8080

® Proxy User — user name needed to access the proxy server

e Proxy User Password — password defined for the user

® Proxy Exclusions — exclusion rules.
These rules define when TREX is not to use the proxy server. Use a semicolon to sepa-
rate multiple entries.

Example

Examples of exclusion rules:
o Do not use the proxy server to get URLs that end in
mycompany.com:mycompany.com .

o Do not use the proxy server to get IP addresses that start with 10.: 10.

Caution

Do not use asterisks as placeholders.
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TREX > Languages for
Document Analysis

TREX supports all main European and Asian languages for indexing and searching.

Only select the languages that are relevant. This optimizes performance during the lan-
guage recognition process and therefore during the search and indexing process. The lan-
guage recognition process gives better results if as few languages as possible are used.
You can also change settings for the language recognition after the installation.

If the application does not transmit the document language to TREX, TREX has to identify
the language before indexing. You can select the languages that you want TREX to recog-
nize.

Caution

Only select the languages that are relevant. This optimizes performance during the lan-
guage recognition process, and therefore during the search and indexing process. The
language recognition process gives better results if as few languages as possible are
used.

1 Note

However, TREX can also index documents whose language is not specified here. TREX
then inserts the documents in question into the index for the default language (nor-
mally English). For example, if you select English and German and a document in Span-
ish is then indexed, the document is inserted into the English index.

This affects the documents in question in the following manner:

e Alinguistic search is not possible.

e TREX may extract keywords (document features) that are not characteristic of the
document.

9.5 Installing a TREX Global File System

The table below shows the names of the screens that are displayed during the installation of a TREX global file
system and the entries that you need to make.
1 Note

For more information about the concept of the global file system, see Installing a TREX Global File System
Only [page 34].

1 Note

For more information about the input parameters, position the cursor on the parameter in the installer GUI

and press 1]
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After the installer has started, the Welcome screen appears:

Screen ‘ Input

Welcome

In the folder hierarchy, choose |} SAP NetWeaver 7.0 <Release> > Standalone Engines >
Search and Classification (TREX) > TREX Global File System with First TREX Instance }

Parameter Mode > Default
Settings

You can choose between Typical Mode or Custom Mode:

e Typical Mode
If you choose Typical, the option is performed with default settings. As a result, you
only have to respond to a small selection of prompts. If you want to change any of the
default settings, you can do so on the Parameter Summary screen. Note that if you
choose the Typical setting and then choose Back after processing one or more input
screens, the Custom setting is activated. You are now guided through all screens with
the default parameters that have been applied in the background so far .

e Custom Mode
If you choose Custom, you are prompted for all parameters. At the end, you can still
change any of these parameters on the Parameter Summary screen .

Media Browser > Software
Package Request

e Provide the path to the media with the TREX 7.0 installation files in Package Location.
® Provide the path to the media with the SAP NetWeaver Kernel 7.20 installation files in
Package Location.

Caution

During the TREX installation, which you perform as the root user (UNIX) or as a user
with administration rights (Windows), the operating system user <SAPSID>adm is cre-
ated. For all operating systems, make sure that the user <sApPSID>adm has at least
read-access to the TREX and the SAP NetWeaver Kernel installation software. Other-
wise, a Python error message can occur during installation.

If the <sAPSID>adm user does not have at least read-access for thefolder containing the
TREX installation files, you can copy the TREX binaries to your local hard-drive. To do this,
specify in CopyPackageTo the path to the directory to which you want to copy the files.

SAP System > DNS Domain
Name

DNS Domain Name for SAP System

FQDN is the fully qualified domain name for an IP address. It consists of the host name
and the domain name: <host name>.<domain name>

Enter the DNS domain name for the SAP system. The DNS domain name is appended to
the server name to calculate the FQDN.

The DNS Domain Name is used to calculate the Fully Qualified Domain Name (FQDN),
which is configured in profile parameter SAPLOCALHOSTFULL. This parameter is needed
to define the URLs for the ABAP and Java application servers. See SAP Note 654982 #r .

DNS has to be configured so that the FQDN can be resolved to an IP address .

1 Note

If your application server host is named kirk.wdf.sap.com, you have to enter
wdf.sap.com.
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I —
Screen ‘ Input

SAP System > General SAP System ID (SAPSID)
Parameters
The SAP system ID <saPSID> is the identifier for the SAP system.
e |fyouinstall a new SAP system, enter the SAP system ID <saps1D> for this system.
e |fyou install the instances of this system on more than one host, make sure that you
assign the same <SAPSID> to all these instances.
e |fyou add instances to an existing SAP system - for example, if you install dialog in-
stances for an existing SAP system - enter the <SAPSTD> of the existing SAP system.
e |fyou uninstall an SAP system, enter the SAP system ID <saps1D> of the SAP system
you want to uninstall.
® (Choose your <saPsID> carefully. Renaming is complicated and requires you to re-in-
stall the SAP system.The ID must be unique throughout your organization and consis-
tent throughout your SAP system installation landscape.
e The ID must consist of exactly three alphanumeric characters.
®  Only uppercase letters are allowed .
® The first character must be a letter (not a digit).
e The following IDs are reserved and cannot be used: ADD ADM ALL AMD AND ANY
ARE ASC AUX AVG BIT CDC COM CON DBA END EPS FOR GET GID IBM INT KEY LOG
LPT MAP MAX MIN MON NIX NOT NUL OFF OLD OMS OUT PAD PRN RAW REF ROW
SAP SET SGA SHG SID SQL SUM SYS TMP TOP UID USE USR VAR.
Caution
When you choose a system ID <saps1D> for your TREX landscape, check which sys-
tem IDs are already in use by other SAP applications on the same host where TREX is
to be installed.
Do not use a system ID <sAPSID> that is already used for another SAP system land-
scape. Otherwise an error message will occur.
SAP System > General .
’ Caution
Parameters
This parameter is only required on Windows.
Installation Drive
This is the drive where the SAP base directory (\usr\sap ) isinstalled.
If saploc already exists, you cannot select the local drive.
Example
If you select D: , the directory \usr\sap is created on drive D.
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I —
Screen ‘ Input

SAP System > General

Caution
Parameters

This parameter is only required on UNIX.

SAP System Mount Directory

The installer retrieves parameters from the SAP system profile directory of an existing
SAP system.

SAP profiles are operating system files that contain instance configuration information.

The installer prompts you to enter the location of the profile directory when the installation
option that you execute is not the first one belonging to your SAP system installation, for
example if you are installing a distributed system or a dialog instance to an existing SAP
system. See also the description of the parameters SAP System ID and Database ID.

/usr/sap/<SAPSID>/SYS/profileisthe softlink referring to /<sapmnt>/
<SAPSID>/profile

SAP System > Master
Passwords

Master Password
Common password for all users that are created during the installation.

We recommend that you use the same master password for each installation of a distrib-
uted scenario.

® Basic password policy:
The master password must meet the following requirements:
o It must be 8 to 14 characters long
o |t must contain at least one letter (a-z, A-Z)
o |t must contain at least one digit (0-9)
o It must not contain \ (backslash) and " (double quote).
e Additional restrictions depending on your operating system:
o Windows:

o If auser already exists, you are prompted to confirm the password for this
user.

o Depending on the configuration of the password policy, additional restric-
tions may apply.
e Other restrictions:
o Depending on the installation option, additional restrictions may apply (for ex-
ample, the master password must not contain the name of a Java user created
during the installation).
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SAP System > Windows
Domain

Caution

This screen and these parameters are only required on Windows

Domain Model

Choose whether you want to create the <sapsid>adm and SAPService <SAPSID>
users:

e Onthe local computer ( Local Installation ).

® |nthe domain of the user who is performing the installation (Use Domain for Current
User)

® |nadomain that is different from the domain of the user who is installing the SAP sys-
tem ( Use Different Domain )

If you want to use the domain of the current user, the <sapsid>admand SAPService
<SAPSID> users can only be created by the installer if the account used for the installation
has domain administrator rights in the domain involved. If not, a user with domain admin-
istrator rights has to create these users before the installation is started. For more infor-
mation, see the installation guide. If the account used is a local user, a local installation is
performed (on the local computer).

If you want to use a different domain, you have to specify the Windows domain.

The <sapsid>admand SAPService <SAPSID> users can only be created in the different
domain by the installer if the account used for the installation has domain administrator
rights in in the other domain. If not, a user with domain administrator rights for this do-
main has to create these users in this domain before the installation is started. For more
information, see the installation guide.

Only choose to create the users on the local computer, if you do not want to install:

e Several application servers (dialog instances) or SAP systems that are using a com-
mon transport directory.
If you choose this option, you can only access the SAP system from another com-
puter, if the same user with the same password exists on both computers and both
computers belong to the same domain or workgroup, or if you authenticate the ses-
sion with user name and password

e A high-availability system with Microsoft Cluster Service (MSCS)

SAP System > OS User
Passwords

Password of the SAP System Administrator user <sapsid>adm

e Password for the operating system user If the user already exists, enter the exact
password of this user .

e Otherwise choose a new password for this user. The installer then creates this user
with the new password

The password policy for creating a new password depends on the settings of your operat-
ing system.

Ask your system administrator if you are not sure about the policy.

72 CUSTOMER

SAP NetWeaver Standalone Engine Search and Classification TREX 7.0 - Single Host
Installation



|
Screen

‘ Input
SAP System > OS User )
Passwords Caution
This parameter is only required on Windows.
Password of the SAP System Service user SAPService<SAPSID>
e Password for the operating system user If the user already exists, enter the exact
password of this user .
e Otherwise choose a new password for this user. The installer then creates this user
with the new password
The password policy for creating a new password depends on the settings of your operat-
ing system.
Ask your system administrator if you are not sure about the policy.
SAP System > OS User ]
Passwords Caution

These parameters are only required on UNIX.

User ID:

Enter the User ID for the user shown, making sure that the ID is unique.
If you do not enter a User ID, the installer assigns a free ID.

Login Shell:

If you use a login shell other than the recommended C shell (csh), see SAP Note 202227

#& for more information.
Home Directory:
The home directory for the specified user

Enter the home directory for the specified user. Make sure that you enter a home directory
that is not critical for recursive changes on permissions.

When operating system users are created by the installer, the permissions on the home
directories of these users are changed recursively. This can cause unpredictable errors if
you define a critical home directory.

Example

Do not enter / or /usr/sap as the home directory.
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10 Post-Installation Configuration

After the Search and Classification (TREX) function has been installed, you perform a number of technical
configuration steps. The following sections describe:
e General configuration steps that you carry out for your operating platform.
e Configuration steps that you only carry out if the application in question communicates with TREX using an
HTTP or an RFC connection.
Server Side [page 74]

Client Side [page 89]

10.1 Server Side

The following sections describe the configuration steps that you have to carry out on the server side.

10.1.1 Configuring TREX for the System Landscape Directory
(SLD)

A modern computing environment consists of a number of hardware and software components that depend on
each other with regard to installation, software updates, and demands on interfaces. The SAP System
Landscape Directory (SLD) simplifies the administration of your system landscape.

The SLD is a server application that communicates with a client application using the Hypertext Transfer
Protocol (HTTP). The SLD server contains component information, a landscape description, and a name
reservation, which are based on the standard Common Information Model (CIM). The CIM standard is a general
schema for describing the elements in a system landscape. This standard is independent of any
implementation.

The component description provides information about all available SAP software modules, as well as their
combination options and dependencies. This includes version numbers, current patch level, and dependencies
between landscape components.

For more information about the SAP System Landscape Directory , see https://help.sap.com/netweaver|p »
SAP NetWeaver 7.0 <Release> ¥ Application Help ¥ Function-Oriented View » SAP NetWeaver by Key
Capability ¥ Solution Life Cycle Management by Key Capability » Software Life Cycle Management » System
Landscape Directory J
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To supply data to the SLD that originates from a system other than a J2EE or ABAP system, the executable
sldregis used. The sldreg sends data in XML format using a predefined DTD. For this purpose it uses an
HTTP connection, as shown in the figure below:

TREX = SAP J2EE Engine
)
S
(N )
2 0| ¢
aQ
XML < 3 »
SAPOSCOL s | § ———
W
z| 2 SLD
HTTP dle
sldreg o g | ®
)
(1]
<
o

On the TREX host, there is an SLD client, which generates an XML file of this type and which registers itself with
the SLD server using sldreg .

Prerequisites

e After the TREX installation, the SLD client and the associated executable files are located on your TREX
host.

e The SLD server is running.

® You or your SLD administrator have generated the SLD configuration files slddest.cfgand
slddest.cfg.key.

1 Note

The slddest.cfg.key file is only available if the configuration of s1dreg was generated using the -
usekeyfile parameter.

® The user specified in the SLD configuration file s1ddest .cfg belongs to the DataSupplierLD user role,
in order to have permission to send the files to the SLD.
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Generating SLD Configuration Files

In case you generate the SLD configuration files (slddest.cfg and slddest.cfg.key ) by yourself you have to know
the host, port, user and password of the SLD server. You generate these configuration files by using the
executable files which are located on your TREX host.

Set the environment variables required by TREX by executing the following scripts in a command prompt in the
<TREX_ DIR> directory:

e UNIX:

o Bourne shell sh, Bourne-again shell bash , Korn shell ksh :
. TREXSettings.sh

o Cshellcsh:
source TREXSettings.csh

e Windows:
0 TREXSettings.bat

Execute the following commands:

e \Without usekeyfile: sldreg -configure <path>/slddest.cfg
e \With usekeyfile: sldreg -usekeyfile -configure <path>/slddest.cfg

Copying the SLD Configuration Files to the Global SLD Directory

To configure TREX for the System Landscape Directory (SLD), you copy the SLD configuration files slddest.cfg
and slddest.cfg.key (if available) to the global SLD directory on your TREX host.

This directory is called <disk_drive>:\usr\sap\<SAPSID>\SYS\global on Windows and /usr/sap/
<SAPSID>/SYS/global on UNIX. In the case of a distributed TREX installation on Windows, all TREX instances
use the configuration files for the TREX global file system with first TREX instance as \
\<host_central_instance>\sapmnt\<SAPSID>\SYS\global.

Result

By copying the files slddest.cfg and slddest.cfg.key , and by you have configured TREX for integration in the
System Landscape Directory (SLD).

TREX checks every five minutes whether anything has changed in the TREX system landscape and reports any
changes automatically to the SLD server. If nothing has changed, TREX reports every twelve hours to the SLD
server. This allows you to see that this landscape is still active.
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Display Results

To display the information about TREX systems and services navigate to the screen Content Maintenance:

e |ntheinitial screen for the System Landscape Directory “Development: Content Maintenance
e |n theinitial screen for the System Landscape Directory ®Administration ® Content: Content Maintenance

In the screen Content Maintenance navigate to Subset and choose All With Instances in the dropdown list.

Navigate to Class. In the dropdown list you can display the TREX Services (for example TREX Index Service,
TREX Name Service) and TREX systems known by SLD.

Information Transferred to the SLD Server

TREX transfers the following information to the SLD server:

e [nformation about naming and version:
o Software component version (for example, TREX 7.0)
o SAP name (for example, TREX)
o Version (for example, 7.0 )
e |nformation about the TREX servers:
o Host name, on which the server is running
o Port number that the server is using
o Type of server, for example, indexserver
o Web server URL (instead of the port)
o RFC destination of the RFC server (instead of the port)
e |nformation about the TREX instances on individual hosts:
o System ID
© Instance number
o Installation directory
o Version information for the TREX software

Information about the TREX configuration:

e Name of the TREX hosts (Hosts ) that belong to the TREX system landscape
e TREX serverroles

o Roles of the TREX name server (Name Server Mode )

Possible roles are: 1st, 2nd, 3rd Master Name Server, Slave Server

o Use as master index server or master queue server

© Roles of the master, slave, and backup index servers
® TREX preprocessor mode (Preprocessor Mode )
e |nformation about the TREX installation directory (Base Path )
e Services that have been started by the TREX daemon (Services )
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10.1.2 General UNIX Configuration

The following sections describe the steps that are necessary after an installation on UNIX.

10.1.2.1 Checking and Changing UNIX Kernel Parameters

Check the following UNIX kernel parameters and modify them if necessary:

Number of open files per process

On UNIX platforms, each process may only have a certain number of files open at once. If you create a
large number of indexes and queues during routine operation, the TREX processes, in particular the queue
server and index server, open a lot of files.

With many UNIX installations, the value for the maximum number of files that the processes are allowed to
have open is too low. The parameter must have the following value:

Operating System ’ Value

AlX, HP-UX, Oracle Solaris At least 2048
Linux At least 1024
HP-UX only:

o Process Size
The process size should be at least 2GB.

1 Note

The process size is not limited for AIX and Oracle Solaris.

Files larger than 2 GB
Since TREX can also use files that are larger than 2GB, these must be activated at operating system level.

The TREX directory contains a test program that you can use to check whether the kernel parameters are set
at a suitable level. If this is not the case, you should change the kernel parameters.

Related Information

Checking Kernel Parameters [page 79]

Changing Kernel Parameters [page 79]
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10.1.2.1.1 Checking Kernel Parameters

Procedure

1. Logonasuser<sapsid>adm.
2. Gotothe TREX directory.

3. Set the environment variables required by TREX:

Option Description

Bourne shell sh, Bourne-again shell bash , Korn shell ksh . TREXSettings.sh

C shell csh source TREXSettings.csh

4. Test the size and number of open files per process using the following command:

portlibtester.x -file
Number of open files:

This command creates test files in the directory /tmp/portlibtester. The test must give a result of at
least 1000 files (Linux) or 2000 files for other UNIX platforms. If this is not the case, you should change the
kernel parameters.

5. Only HP-UX: Test the possible process size using the following command:
portlibtester.x —-mem

This command calls upon as much main memory as possible. The test must output the value 1900 MB at
least. If this is not the case, you should change the kernel parameters.

10.1.2.1.2 Changing Kernel Parameters

Related Information

Changing Kernel Parameters on AlX [page 80]
Changing Kernel Parameters on HP-UX [page 80]
Changing Kernel Parameters on Linux [page 81]
Changing Kernel Parameters on Oracle Solaris [page 82]
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10.1.2.1.2.1 Changing Kernel Parameters on AlX

Procedure

1. Logonasauserwith root authorizations.
2. Carry out the following steps as appropriate, depending on whether you are working with or without a
Network Information System (NIS).

o (Without NIS) Execute the following command:
chuser nofiles=2000 trx<instance_ number>

o (With NIS) Add the following entry to the file /etc/security/limits:
trx<instance_number>: nofiles=2000

3. Restart the host using reboot.

Results

After making the change, execute portlibtester.x —file again. If the number of open files is still too low,
the UNIX system administrator must have restricted this parameter in another way. Contact the UNIX system
administrator to remove this restriction.

10.1.2.1.2.2 Changing Kernel Parameters on HP-UX

Procedure

e Changing the process size
a. Logonasauser with root authorizations.
b. Open the administration tool SAM (usr/sbin/sam).
c. Setat least the following values in the dialog box kernel configuration/configurable.

Kernel Parameter ’ Lowest Acceptable Value

Process Size

maxdsiz 0X80000000 or 2147483648

maxdsiz_64bit 0X80000000 or 2147483648
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|
Kernel Parameter ’ Lowest Acceptable Value

maxtsiz 0X40000000 or 1073741824

maxtsiz_64bit 0X40000000 or 1073741824

Number of Open Files

maxfiles 2048
maxfiles_lim 2048
nfile 20000

e Activating files larger than 2 GB

a. Logonas auser with root authorizations.
b. Execute the following command:

fsadm -o largefiles <mount-point>

In doing this, you activate usage of files larger than 2 GB on a certain file system.

Results

After making the change, execute portlibtester.x —file again. If the number of open files is still too low,
the UNIX system administrator must have restricted this parameter in another way. Contact the UNIX system
administrator to remove this restriction.

10.1.2.1.2.3 Changing Kernel Parameters on Linux

Procedure

1. Add the following line to the end of the script <TREX DIR>/TREXSettings.sh:
ulimit -n 1024
2. Add the following line to the end of the script <TREX DIR>/TREXSettings.csh:

unlimit openfiles

1 Note

TREXSettings.csh is not relevant for the TREX daemon. It is only relevant if you start the TREX
servers manually or execute test scripts.

3. Ifthe TREX daemonis running, restart it.
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Results

After making the change, execute portlibtester.x —file again. If the number of open files is still too low,
the UNIX system administrator must have restricted this parameter in another way. Contact the UNIX system
administrator to remove this restriction.

Next Steps

If you receive error messages during indexing, the value 1024 for the number of open files may not be
sufficient. If this is the case, run TREX on root (you can only raise the parameter value to 2048 on root).
Proceed as follows:

Make sure that the script <TREX DIR>/TREXSettings.sh contains the following line at the end:
ulimit -n 2048

Make sure that the script <TREX DIR>/TREXSettings.csh contains the following line at the end:
unlimit openfiles

TREXSettings.cshis not relevant for the TREX daemon. It is only relevant if you start the TREX servers
manually or execute test scripts.

Add a comment sign to the configuration file <TREX DIR>/<host name>/TREXDaemon.ini before the
following lines:

#userid = trx<instance number>
#groupid = <group>

This change causes the TREX daemon to run on root next time it starts.

10.1.2.1.2.4 Changing Kernel Parameters on Oracle Solaris

Procedure

1
2.

3.

82

Log on as a user with root authorizations.
Add the following lines to the configuration file /etc/system:

© set rlim fd max=2048

© set rlim fd cur=2048

Restart the host using reboot.
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Results

After making the change, execute portlibtester.x —file again. If the number of open files is still too low,
the UNIX system administrator must have restricted this parameter in another way. Contact the UNIX system
administrator to remove this restriction.

10.1.3 Configuration of the RFC Connection

Context

The following sections describe the steps that you carry out if the application and TREX are communicating
using an RFC connection.

Procedure

1. Define the SAP system users.

For more information, see Creating a SAP System User for the TREX Admin Tool (Stand-Alone) [page 84]
2. Determine the SAP system connection data.

For more information, see Determining the SAP System Connection Information [page 85]
3. Configure the RFC connection in the TREX admin tool using the TREX admin tool (stand-alone).

For more information, see Configuring the RFC Connection in the TREX Admin Tool [page 86]

1 Note

For more information about how you start the TREX admin tool (stand-alone), see Starting the TREX
Admin Tool [page 103].

Results

For more information about the RFC connection and handling connection and configuration errors, see the
documentation on the TREX admin tool (stand-alone). You can find this documentation in the SAP Library at:

http://help.sap.com/netweaver|l » SAP NetWeaver 7.0<Release> # Application Help  Function-Oriented
View » *SAP NetWeaver by Key Capability » Information Integration by Key Capability » -> Search j» -> Search
and Classification TREX » -> TREX 7.0 for SAP NetWeaver 7.0 » -> TREX Administration » -> TREX Admin
Tools » -> TREX Admin Tool (Stand-Alone) 3
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10.1.3.1 Creating a SAP System User for the TREX Admin Tool
(Stand-Alone)

Context

You must create an SAP user that the TREX admin tool (stand-alone) can use to log on to the SAP system. In
addition, the SAP user is required so that the TREX alert server has permission to regularly test and check the
RFC configuration.When doing this, the user can have been created in the default client or in another client. In
this case, make sure that you enter the associated client for the user during the configuration of the RFC
connection in the TREX admin tool.

The TREX admin tool (stand-alone) is used to configure and monitor TREX. You also use this admin tool to
configure the RFC connection between TREX and the ABAP application that is using TREX. To use the TREX
admin tool (stand-alone) to createthe RFC destination, the TREX admin tool requires a SAP system
user that you create based on the predefined role SAP_BC_TREX ADMIN . This user then has the authorization
required to configure the RFC connection.

1 Note
You can find current information about the role SAP BC_TREX_ ADMIN in SAP Note 766516 .

Overview of the permissions assigned by the SAP_BC_TREX_ADMIN role

Type and Scope of the Permission ’ Activity ’ Explanation

Pemrriicshten aleek for [FEC SEeEss Execute Name of the RFC object to be pro-
tected: SYST, TREX_ARW_ADMINIS-
TRATION

A o (he G cesinetien Add or generate, change, display, de- | Type of entry in RFCDES: Start of an

lete, extended maintenance external program via TCP/IP

Check on the transaction code at = Transaction code: SM59, TREXADMIN,

transaction launch TREXADMIN_AUTH

TREX administration Change, display, execute =

ABAP: Program run checks Schedule programs for background =

processing, execute ABAP program,
maintain variants for and execute

ABAP program
ALV standard layout Maintain =
Application log Display, delete =

Procedure

1. Create a SAP system user for the TREX admin tool (stand-alone) and assignthe
SAP BC_TREX ADMIN role to this user.
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2. Launch transaction su01 (user maintenance) or choose in the SAP menu | Administration » System

Administration » User Maintenance » User 3.
The User Maintenance: Initial Screen appears.

3. Enter a new user name and choose Create .
4. Onthe Address tab page, enter the personal data for the user.

5. Onthe Roles tab page, assign the SAP BC_TREX ADMIN role and thus the permission to access the SAP
system to the SAP system user for the TREX admin tool (stand-alone).

Results

This user for the TREX admin tool (stand-alone) now has the authorization required to configure the
RFC connection.

Related Information

Configuring the RFC Connection in the TREX Admin Tool [page 86]

10.1.3.2 Determining the SAP System Connection
Information

Context

The TREX admin tool (stand-alone) canconnecttoan SAP system intwo ways.

e Through a specific application server of the SAP system (variant A)
® Through the message server of the SAP system (variant B)
o This variant uses the load-balancing function for the SAP system. The message server assigns the
request from the TREX admin tool to any application server.

Depending on the variant used, the TREX admin tool requires different connection information for the SAP
system. You must determine the connection information and specify it later in the TREX admin tool.

=+ Recommendation

SAP recommends using variant B. Variant A has the disadvantage that the connection does not work if the
application server is not available.
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Procedure

1. Open the SAP Logon.
SAP Logon is the program that you use to log on to an SAP system.

2. Note the following connection information:

Connection Setup Type Required Connection Information
(0]

SAP system ID (SID)
System number
o Application server host name

Through an application server (variant A)

Through the message server (variant B) o SAP system ID (SID)
Logon group, such as PUBLIC
Message server host name

10.1.3.3 Configuring the RFC Connection in the TREX Admin
Tool

Context

You work through the steps below using the TREX admin tool (stand-alone).

Related Information

Creating a Connection [page 86]
Creating an RFC Destination [page 87]
Completing the RFC Configuration [page 88]

10.1.3.3.1 Creating a Connection

Procedure

1. Inthe Landscape RFC window, choose the Create Connection function.
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2. Choose connection type A or B. Specify the connection data for the SAP system.

For more information, see Determining the SAP System Connection Information [page 85]

3. Specify the SAP system user, the associated password, and the client that the TREX admin tool isto use

to log on.

For more information, see Creating a SAP System User for the TREX Admin Tool (Stand-Alone) [page 84]

1 Note

If the SAP system user in question exists in the default client, you do not need to specify the client.

10.1.3.3.2 Creating an RFC Destination

Procedure

1. Inthe Landscape RFC window, choose the REC Destination (SM59) function.

2. Enter the following parameters:

Option

Description

SAP System

SAP system that you want to set up the connection to.

The list contains all SAP systems that you have registered using Create Connection .

RFC Destination

Name of the RFC destination.

Description

Meaningful description of the purpose

3. Decide which SAP gateway you want to use. You have the following options:

Option Description

Option Comment

Gateway local Use local SAP gateways for the application servers.
(Default set-

ting)

Gateway central | Use the central SAP gateway.

1 Note

We advise against using a central SAP gateway for distributed TREX systems. The central SAP
gateway is a “single point of failure”.
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Description

If you choose this option, enter the following additional parameters:

o Host name (with domain name if necessary) or the IP address of the host on which the gateway
is installed.

© Name of the SAP gateway in the form sapgw<instance_number>

Next Steps

SAP advises against creating the RFC destination directly in the SAP system. The name of the RFC destination
and the program ID must satisfy certain naming conventions. The TREX admin tool ensures that these are
fulfilled.

If you nevertheless create the RFC destination directly in the SAP system, note the following:

® Werecommend starting the name of the RFC destination with TREX__.
e Choose the activation type Registered Server Program .
e Choose a program ID that is unique for the SAP gateway used.

Use the RFC Destinations function to register the RFC destination in the TREX admin tool.

10.1.3.3.3 Completing the RFC Configuration

Procedure

1. Inthe Landscape RFC window, choose the Connect function.
The TREX admin tool creates the connection to all SAP systems that are known to it. Because the RFC
configuration is still incomplete, the configuration status is AY yellow or B g

2. Choose Repair All .
The TREX admin tool completes the RFC configuration and starts the TREX RFC server. This can take
several minutes. During this time, the configuration status remains A yellow or B eq. After completion
of the configuration process, the status changes to Bgreen.

Do not choose Repair All several times in quick succession. This would trigger the configuration process
more than once and delay it.

3. Check the progress by choosing Refresh to update the display.
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10.2 Client Side

The following sections describe the configuration steps that you have to carry out on the client side.

10.2.1 Java Application

If a Java application communicates with TREX, you configure the TREX Java client, which is integrated as a
TREX service in the J2EE engine. You also check the client-side proxy settings.

10.2.2 Specifying the Address of the TREX Name Server

Context

TREX provides APIs (Application Programming Interfaces) for the languages Java and ABAP, which allow
access to all TREX functions. The Java interface (TREX Java client) is part of the SAP Web AS Java as TREX
service. The TREX Java client needs to know the address of the TREX name server in order to communicate
with the TREX servers.

The following procedure describes how you determine the TREX name server address and how you specify it in
the SAP NetWeaver Visual Administrator .

1 Note

The TREX Java client communicates with the TREX server by HTTP and TCP/IP. Make sure that the TCP port
that the name server uses is open.

Procedure

1. You have to specify the address of the TREX name server in the SAP NetWeaver Visual Administrator by
naming the following values:

<host name of trex host>:<name_ server port>
© <host name of trex host>:name of the host on which TREX s installed and where the TREX

name server runs.
© <name server port>:portofthe TREX name server

2. You can determine the TREX name server address in two ways:
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a. Startthe TREX admin tool (see Starting the TREX Admin Tool [page 103]) and determine the address
of the name server using | Landscape » Tree ¥ topology # globals ¥ all_masters 3.

Example

mytrexhost:34801

b. Determine the port of the TREX name server by means of the following rule:
<name server port>:3<instance number>0l
The value <instance number> signifies the TREX instance number which had been specified during
the TREX installation:
Installation directory for TREX
o OnUNIX: /usr/sap/<sapsid>/trx<instance number>
o OnWindows: <disk drive>:\usr\sap\<SAPSID>\TRX<instance number>
The value for <host _name of trex host>you know from the host where TREX is installed
(mytrexhost) .

. Use the user <j2eeadm> to log onto the host on which the J2EE Engine is running.

4. Start the SAP NetWeaver Visual Administrator and log on to the J2EE Engine.

For more information about using SAP NetWeaver Visual Administrator, see http://help.sap.com/
netweaver|p » SAP NetWeaver 7.0 <Release> # Application Help ¥ Function-Oriented View » SAP
NetWeaver by Key Capability ¥ Application Platform by Key Capability ¥ Java Technology ¥ Administration
Manual » J2EE Engine » J2EE Engine Administration Tools » Visual Administrator J

5. Click Cluster and navigate to |[» Services » TREX Service 3.

6. Enter the address of the TREX name server into the parameter nameserver.address.

tcpip://<host _name of trex host>:<name server port>

You enter only the host name or the host name and the domain depending on your network environment.

Example

tcpip://mytrexhost:34801 or tcpip://mytrexhost.mydomain:34801

Caution

The address of the TREX name server must be configured for all server processes of the cluster.
Otherwise the connection between the J2EE Engine and TREX cannot be established.

7. Save your changes and confirm the restart of the service.

10.2.3 Checking Proxy Settings

If an application is unable to communicate with TREX, it may be due to the application trying to access TREX
using a proxy server. If this is the case, you have to change the configuration so that access does not take place
using the proxy server.
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The procedure depends on the application concerned:

e SAP Enterprise Portal 6.0 with Content Management
e Other Java applications based on J2EE 6.40

SAP Enterprise Portal 6.0 with Content Management

Check the settings in the portal at |+ System Administration ¥ System Configuration ¥ Service Configuration ¥
Applications (Content Catalog) » com.sap.portal.ivs.httpservice » Services ¥ proxy 3.

If a proxy server is entered there, you have to enter the TREX host in the field http — Bypass Proxy Servers.

Other Java applications based on J2EE 6.40

For other Java applications, you have to check the configuration of the J2EE Engine. The proxy settings belong
to the Java parameters. If a proxy server is configured in the Java parameters, enter the TREX host in the
parameter nonProxyHosts . You can choose one of the following options:

e Alternative 1: D"http.nonProxyHosts=<hostname>.<mydomain>| localhost
For <hostname>.<domain>,enter the host name and domain (if necessary) of the TREX host.

e Alternative 2.D"http.nonProxyHosts=*.<mydomain>|localhost

You can change the Java parameters using the SAP J2EE Engine GUI Config Tool..For more
information about using this tool, see http:/help.sap.com/netweaver|p » SAP NetWeaver 7.0 <Release> ¥
Application Help ¥ Function-Oriented View ¥ SAP NetWeaver by Key Capability ¥ Application Platform by Key
Capability ¥ Java Technology ¥ Administration Manual » J2EE Engine ¥ J2EE Engine Administration Tools »
Config Tool 3.

Caution

Note that you have to specify the name of the TREX host in the same way both on TREX side in the TREX
configuration files (topology.ini, sapprofile.ini ) and in the configuration of the J2EE Engine as
described above. In case you specify the TREX host name as fully qualified (for example
PWDF12345.sap.corp ) you have to do so on both sides. A mixed usage of host names does not work.
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11 Installation Check

If you have carried out all the steps described, TREX is ready for operation. You can carry out checks to
ascertain whether the installation was successful.

Checking Processes [page 92]
Executing an Installation Test Script [page 93]

11.1 Checking Processes

You can check on operating systems whether the TREX daemon is running and whether the required process
has started.

Procedure on UNIX

Process HTTP Connec- | RFC Con-
tion nection
httpdTREXDaemon .x W
1 Note

For the process TRExDaemon . x the symlink trx.sap<SAPSID>

_TRX<instance number> will be shown. This is a symlinkto usr/sap/<SAPSID>/

TRX<instance number>/exe/TREXDaemon. x
TREXIndexServer.x W ]
TREXNameServer.x W W
TREXPreprocessor.x W v
TREXQueueServer.x W W
TREXRfcServer.x W
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Procedure on Windows

Open the Task Manager and check whether the following programs are running:

Process ’ HTTP Connection ’ RFC Connection
TREXDaemon.exe W W
TREXIndexServer.exe W W
TREXNameServer.exe W W
TREXPreprocessor.exe W W
TREXQueueServer.exe W W
TREXRfcServer.exe ]

11.2 Executing an Installation Test Script

Context

TREX delivers a Python script that you can use to test the basic functions of TREX. If the Python script is
executed successfully, you know that TREX has been installed properly, the configuration files contain the
necessary entries, and the TREX servers are running.

Related Information

Procedure on UNIX [page 94]
Procedure on Windows [page 95]
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11.2.1 Procedure on UNIX

Procedure

1. Logonasuser <sapsid>adm.
2. Gotothe TREX directory.
cd /usr/sap/<SAPSID>/trx<instance_ number>
3. Set the environment variables required by TREX by executing one of the following scripts.
© Bourne shell sh, Bourne-again shell bash , Korn shell ksh :
. /TREXSettings.sh

o Bourne shell sh, Bourne-again shell bash , Korn shell ksh :
source TREXSettings.csh

4. Go to the directory in which the test script is located:
cd /usr/<SAPSID>/trx<instance number>/exe/python_support
5. Torun the test script, enter the following:

python runInstallationTest.py

Results

The script carries out the following tests:

e Deleting any test indexes that were generated for a previous script run
e C(Creating a test index
® |ndexing documents
e Testing search functions
o Exact, error-tolerant (fuzzy), and linguistic searches
o Search using Boolean operators such as AND and OR

The results are displayed at the end of the script run. You see the tested calls and their statuses (0K or
Failed)

When you run the script for the first time, the call “Delete Index” has the status Failed . This is because there
was no existing text index to be deleted. If this is the only cell with the status Failed, the test was successful.
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11.2.2 Procedure on Windows

Procedure

1. Logonasuser <sapsid>adm.

2. Open atest console by choosing |+ Start » Programs 3 or | All Programs » SAP TREX ¥ Instance
<instance number> » Tools » TREX_<instance number> Console J.

3. Run the test script in this directory:
python runInstallationTest.py

Results

The script carries out the following tests:

e Deleting any test indexes that were generated for a previous script run
e C(Creating a test index
® [ndexing documents
e Testing search functions
o Exact, error-tolerant (fuzzy), and linguistic searches
o Search using Boolean operators such as AND and OR

The results are displayed at the end of the script run. You see the tested calls and their statuses (0x or
Failed).

When you run the script for the first time, the call “Delete Index” has the status Failed . This is because there
was no existing text index to be deleted. If this is the only cell with the status Failed, the test was successful.
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12 Additional Information

Additional Information about the Installer [page 96]
Starting the TREX Admin Tool [page 103]

Starting and Stopping TREX [page 104]
Uninstalling TREX [page 111]

12.1 Additional Information about the Installer

Interrupted Installation [page 96]
Troubleshooting with the Installer [page 101]
Using the Step State Editor (SAP Support Experts Only) [page 102]

12.1.1 Interrupted Installation

The SAP system installation might be interrupted for one of the following reasons:

® Anerror occurred during the Define Parameters or Execute phase.
The installer does not abort the installation in error situations. If an error occurs, the installation pauses
and a dialog box appears. The dialog box contains a short description of the choices listed in the table
below as well as a path to a log file that contains detailed information about the error.

® You interrupted the processing of the installer by choosing Cancel in the SL Common GUI.

Caution

If you stop an option in the Execute phase, any system or component installed by this option is
incomplete and not ready to be used. Any system or component uninstalled by this option is not
completely uninstalled.
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The following table describes the options in the dialog box:

Option Definition

Retry The installer retries the installation from the point of failure without repeating any of
the previous steps.
This is possible because the installer records the installation progress in the
keydb.xml file.
We recommend that you view the entries in the log files, try to solve the problem, and
then choose Retry.
If the same or a different error occurs, the installer displays the same dialog box
again.

Stop The installer stops the installation, closing the dialog box, the installer GUI, and the
GUI server.
The installer records the installation progress in the keydb . xm1 file. Therefore, you
can continue the installation from the point of failure without repeating any of the
previous steps. See the procedure below.

Continue The installer continues the installation from the current point.

View Log Access installation log files.

1 Note

UNIX only: You can also terminate the installer by choosing Ctrl+C. However, we do not recommend this,
because it kills the process immediately.

Related Information

Procedure on UNIX [page 97]
Procedure on Windows [page 99]

12.1.1.1 Procedure on UNIX

Procedure

1. Make sure that you are logged on to your local UNIX host as user root.
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2. Restart the installer from the directory to which you unpacked the 70sWpPM10SP<support package
number> <version number>.SAR file by executing the following command: /<path to unpack
directory>/sapinst

3. Theinstaller is restarting.
The installer now starts and waits for the connection with the SL Common GUI.

You can find the URL you require to access the SL Common GUI at the bottom of the shell from which you
are running the installer.

Sample Code

;;;*************************************************************************
* % k%

Open your browser and paste the following URL address to access the GUI
https://[<hostname>]:4237/sapinst/docs/index.html

Logon users: [<users>]
khkhkhkkhkhhkhhkdhhhhkhhkhhkhhhkhkrkhkhhkhhkhkhkrhkhhkhhhkhrhkhhkhhkdhhkhkhkhr kb khhkhkhk ok bk hkhkhkrhkhkhkhkhkhhhkxxk

* %k ok

If you have a supported web browser installed on the host where you run the installer, you can open this
URL directly in the shell. Otherwise open the URL in a supported web browser that runs on another device.

The SL Common GUI opens in the browser by displaying the Welcome screen.

1 Note

Before you reach the Welcome screen, your browser might warn you that the certificate of the sapinst
process on this computer could not be verified. Accept this warning to inform your browser that it can
trust this site, even if the certificate could not be verified.

4. From the tree structure in the Welcome screen, select the installation option that you want to continue and

choose Next .
The What do you want to do? screen appears.

5. Inthe What do you want to do? screen, decide between the following alternatives and choose OK:
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Alternative

Perform a new run

Behavior

The installer does not continue the interrupted installation option. Instead, it
moves the content of the old installer directory and all installer-specific files to
a backup directory. Afterwards, you can no longer continue the old option.

The following naming convention is used for the backup directory:

log <Day> <Month> <Year> <Hours> <Minutes> <Seconds>

Example

log 01 Oct 2016 13 47 56

1 Note

All actions taken by the installation before you stopped it (such as creating
directories or users) are not revoked.

Caution

The installer moves all the files and folders to a new log directory, even if
these files and folders are owned by other users. If there are any processes
currently running on these files and folders, they might no longer function

properly.

Continue with the existing one

The installer continues the interrupted installation from the point of failure.

12.1.1.2 Procedure on Windows

Procedure

1. Make sure that you are logged on to your remote host as a user who is a member of the local

administrators group.

2. Restart the installer by double-clicking sapinst.exe from the directory to which you unpacked the

70SWPM10SP<support package number> <version number>.SAR file.

3. Theinstaller is restarting.

The installer now starts and waits for the connection with the SL Common GUI. If you have a supported
web browser installed on the host where you run the installer, the SL Common GUI starts automatically by

displaying the Welcome screen.

If the SL Common GUI does not open automatically, you can find the URL you require to access the SL
Common GUI at the bottom of the Program Starter window of the installer. You find the icon of the Program
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Starter window in the taskbar of your Windows host. Open a supported web browser and run the URL from
there.

Sample Code

;;;*************************************************************************
* Kk Kk

Open your browser and paste the following URL address to access the GUI
https://[<hostname>] :4237/sapinst/docs/index.html

Logon users: [<users>]
R R i S I I S S b I b I S i S b I b b I b I S b S I I I e S b I b I b SR S b I S e b I I b b b b b b b b S 2 S b b i 4

* Kk Kk Kk

The SL Common GUI opens in the browser by displaying the Welcome screen.

1 Note

Before you reach the Welcome screen, your browser might warn you that the certificate of the sapinst
process on this computer could not be verified. Accept this warning to inform your browser that it can
trust this site, even if the certificate could not be verified.

4. From the tree structure in the Welcome screen, select the installation option that you want to continue and

choose Next .
The What do you want to do? screen appears.

5. Inthe What do you want to do? screen, decide between the following alternatives and choose OK:
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Alternative Behavior

Perform a new run The installer does not continue the interrupted installation option. Instead, it
moves the content of the old installer directory and all installer-specific files to
a backup directory. Afterwards, you can no longer continue the old option.

The following naming convention is used for the backup directory:

log <Day> <Month> <Year> <Hours> <Minutes> <Seconds>

Example

log 01 Oct 2016 13 47 56

i Note

All actions taken by the installation before you stopped it (such as creating
directories or users) are not revoked.

Caution

The installer moves all the files and folders to a new log directory, even if
these files and folders are owned by other users. If there are any processes
currently running on these files and folders, they might no longer function

properly.

Continue with the existing one The installer continues the interrupted installation from the point of failure.

12.1.2 Troubleshooting with the Installer

Context

This section tells you how to proceed when errors occur during the installation with the installer.

If an error occurs, the installer:

e Stops the installation.
e Displays a dialog informing you about the error.

Procedure

1. Check SAP Note 1548438#% for known installer issues.
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2. Ifanerror occurs during the Define Parameters or the Execute Service phase, do one of the following:

o Try to solve the problem:

o Tocheck the installer log files (sapinst.logand sapinst dev.log) for errors, choose the LOG
FILES tab in the SL Common GUI.

o To check the log and trace files of the installer GUI for errors. You can find them in the directory
%userprofile%\.sapinst\ (on Windows) or <User Home>/.sapinst/ (on UNIX)inthe SL
Common GUI .

o Then continue by choosing Retry.

o If required, abort the installer by choosing Cancel in the tool menu of the SL Common GUI.
Restart the installer as described in Interrupted Installation [page 96].

3. If you cannot resolve the problem, report an incident using the appropriate subcomponent of BC-INS*,

For more information about using subcomponents of BC-INS* see SAP Note 1669327 #r .

12.1.3 Using the Step State Editor (SAP Support Experts
Only)

1 Note

Only use the Step State Editor if SAP Support requests you to do so, for example to resolve a customer
incident.

Prerequisites

SAP Support requests you to use the Step State Editor.

Procedure

1. Start the installer from the command line as described in Running the Installer [page 37] with the
additional command line parameter SAPINST SET STEPSTATE=true.

2. Follow the instructions on the installer screens and fill in the parameters prompted during the Define
Parameters phase until you reach the Parameter Summary screen.

3. Choose Next.

The Step State Editor opens as an additional dialog. Within this dialog you see a list of all steps to be
executed by the installer during the Execute Service phase. By default all steps are in an initial state.
Underneath of each step you see the assigned installer component. For each step you have a Skip and a
Break option.

o Mark the checkbox in front of the Break option of the steps where you want the installer to pause.
o Mark the checkbox in front of the Skip option of the steps which you want the installer to skip.
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4. After you have marked all required steps with either the Break or the Skip option, choose OK on the Step
State Editor dialog.

The installer starts processing the Execute Service phase and pauses one after another when reaching
each step whose Break option you have marked. You can now choose one of the following:

o Choose OK to continue with this step.

o Choose Step State Editor to return to the Step State Editor and make changes, for example you can
repeat the step by marking the checkbox in front of the Repeat option.

o Choose Cancel to abort the installer.

5. Continue until you have run through all the steps of the Execute Service phase of the installer.

12.2 Starting the TREX Admin Tool

Prerequisites

On UNIX: Since the TREX admin tool has a graphical interface, you need an X server. You cannot use a
terminal program that only supports text mode, such as telnet.

Procedure

1. Logonasuser <sapsid>adm.

2. Carry out one of the following steps:
UNIX Enter the following:
cd <TREX DIR>

./TREXAdmin. sh

Windows | Choose | Start 3 Programs 4 or | All Programs » SAP TREX ¥ Instance <instance number> # Tools
» TREX Administration 4

1 Note

You can also start the TREX admin tool by double-clicking <TREX_DIR>\TREXAdmin.bat in Win-
dows Explorer.
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12.3 Starting and Stopping TREX

You can use the following methods to start and stop TREX:

Windows

e SAP Microsoft Management console
e SAP Management Console
® [Executable files startsap.exe and stopsap.exe

UNIX

e SAP Management Console
® [Executable files startsap and stopsap

Starting and Stopping the TREX Web Server and Individual TREX Servers

When administrating TREX, you may need to stop (and then restart) the TREX Web server (Windows: IIS/UNIX:
Apache) and individual TREX servers.The procedures differ depending on whether you are using Windows or
UNIX.

SAP Management Console

The SAP Management Console (SAP MC) provides a common framework for centralized system management.
It allows you to monitor and perform basic administration tasks on the SAP system centrally, which simplifies
system administration.

The SAP MC is a Java applet that can be run from any Web browser supporting Java. You can therefore
administer remote systems without needing a local installation.

For more information about the SAP Management Console, see http://%20help.sap.com/netweaverFr|jr SAP
NetWeaver 7.0 <rRelease>  Application Help » SAP NetWeaver by Key-Capability # Solution Lifecycle
Management » Solution Monitoring ¥ Monitoring in the CCMS » SAP Management Console .
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SAP Microsoft Management Console

You use the SAP Microsoft Management console, a snap-in in the Microsoft Management Console (MMC) , to
start and stop SAP systems and TREX instances. The snap-in consists of a root node of the SAP system, below
which the various SAP systems and their TREX instances appear as subnodes. The system displays detailed
information about the processes, the current status, and open alerts for the instances.

A newly-installed MMC allows you only to start a locally-installed SAP instance on the host that you are logged
on to. If the MMC is configured for central system administration, you can start and stop the entire SAP system
from a single host.

For more information about the SAP Management Console, see http://%20help.sap.com/netweaver | SAP
NetWeaver 70 <Release> » Application Help » SAP NetWeaver by Key-Capability » Solution Lifecycle
Management » Solution Monitoring » Monitoring in the CCMS » SAP Microsoft Management Console :
Windows 3.

As part of the installation of the global file system, the SAP service for the corresponding TREX instance
(SAP<sapsid> TRX<instance number>) isregistered as a Windows service. The service is configured so
that it starts automatically when the host is started up, and stops automatically when the host is shut down.

You can start and stop the service manually if necessary. You can also start the TREX servers individually for
test purposes or troubleshooting.

Prerequisites

During the installation of the global file system, a SAP Management console has been installed on your host
machine.

Executable Files startsap and stopsap

You use the executable files startsap.exe and stopsap.exe (Windows), startsap and stopsap (UNIX) to
start and stop TREX. After installation of the TREX instance, these files are located in the directory
<TREX_ DIR>\exe (Windows), <TREX DIR>/exe (UNIX).

Related Information

Starting TREX [page 106]
Stopping TREX [page 109]
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12.3.1 Starting TREX

The following sections describe in detail how to start TREX in the different ways listed above.

12.3.1.1 Using the SAP Management Console to Start TREX

You can use the SAP Management Console (SAP MC) to start TREX.

Related Information

Starting the Web-Based SAP Management Console [page 106]
Registering Systems and Instances in the SAP Management Console [page 107]
Starting a TREX Instance [page 107]

12.3.1.1.1 Starting the Web-Based SAP Management Console

Procedure

1. Start a Web browser and enter the following URL:
http://<hostname>:5<instance number>13

Example

If the instance number is 53 and the host name is saphost06 , you enter the following URL: http://
saphost06:55313

This starts the SAP MC Java applet.

1 Note

If your browser displays a security warning message, choose the option that indicates that you trust the
applet.

2. Choose Start.

The SAP Management Console appears.
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1 Note

When you start the SAP MC for the first time for a newly installed SAP system, you have to register your
system as described in Registering Systems and Instances below. After you have done this, the
instances installed on the host you have connected to are already present in the SAP Management
Console when you next start the SAP MC.

12.3.1.1.2 Registering Systems and Instances in the SAP
Management Console

Context

You can extend the list of systems and instances displayed in the SAP MC, so that you can monitor and
administer all systems and instances from a single console. You can configure the SAP MC startup view to
display the set of systems and instances you want to manage.

Procedure

1. Inthe SAP MC, choose | File » New 3.

2. Inthe New System dialog box, enter the required data.

If you have already registered systems in the SAP MC, they are stored in the history. To open the System'’s
History dialog box, choose the browsing button next to the Instance Nr. field. Select an instance of the
system that you want to add and choose OK.

3. Choose Finish.

12.3.1.1.3 Starting a TREX Instance

Procedure

1. Select the TREX instance you want to start and choose Stop from the context menu.
2. Inthe Start SAP System(s) dialog box, choose the required options.
3. Choose OK.
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The system might prompt you for the SAP system administrator credentials. To complete the operation,
you require administration permissions. Log in as user <sapsid>adm.

The SAP MC starts the specified TREX instance.

12.3.1.2 Using the SAP Microsoft Management Console to
Start TREX

Procedure

1. Logonasuser<sapsid>adm.
2. Launch the SAP Management console by double-clicking the program icon on your desktop or by choosing
| Start » Programs » SAP Management Console 3.

3. Inthe tree structure, choose the node for the central SAP instance <sAPsID> and navigate to the subnode
for the TREX instance <host> <instance number> ( for example, p123456_77).

4. Choose the right-hand mouse button to access the context menu.
5. Choose Start .

12.3.1.3 Windows: Using startsap.exe to Start TREX

Procedure

1. Logonasuser<sapsid>adm.

2. Openacommand prompt by choosing |» Start » Programs » <Instance number> » Tools »
TREX_<instance number> 7 so that the environment variables are set correctly.

3. Switchto the <TREX DIR>/exe directory and enter the following:
startsap.exe name=<SAPSID> nr=TRX<instance number> SAPDIAHOST =<host>

In the SAPDIAHOST parameter, you specify the host name on which the TREX instance should be started.

Example

startsap.exe name=ABC nr=TRX77 SAPDIAHOST =pl23456
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12.3.1.4 UNIX: Using startsap to Start TREX

Procedure

1. Logonasuser<sapsid>adm.
2. Enter the following command:

startsap <TREX instance>

Example
The following command starts a TREX instance with instance number 77:

startsap TRX77

12.3.2 Stopping TREX

The following sections describe in detail how to stop TREX in the different ways listed above.

12.3.2.1 Using the SAP Management Console to Stop TREX

Procedure

1. Start the SAP Management Console (SAP MC) as described in Starting the Web-Based SAP Management
Console [page 106]

2. Select the TREX instance you want to stop and choose Stop from the context menu.
3. Inthe Stop SAP System(s) dialog box, choose the required options.
4. Choose OK.

The system might prompt you for the SAP system administrator credentials. To complete the operation,
you require administration permissions. Log in as user <sapsid>admn.

The SAP MC stops the specified TREX instance.
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12.3.2.2 Using the SAP Microsoft Management Console to
Stop TREX

Procedure

1. Logonasuser<sapsid>adm.
2. Launch the SAP Management console by double-clicking the program icon on your desktop or by choosing
|» Start » Programs » SAP Management Console 3.

3. Inthe tree structure, choose the node for the central SAP instance <saPsID> and navigate to the subnode
for the TREX instance <host> <instance number> (for example, p123456_77).

4. Choose the right-hand mouse button to access the context menu.
5. Choose Stop .

12.3.2.3 Windows: Using stopsap.exe to Stop TREX

Procedure

1. Logonasuser<sapsid>adm.

2. Open a command prompt by choosing | Start » Programs # <Instance number> » Tools »
TREX_<instance number> 7 so that the environment variables are set correctly.

3. Switch to the <TREX DIR>/exe directory and enter the following:
stopsap.exe name=<SAPSID> nr=TRX<instance number> SAPDIAHOST =<host>

In the SAPDIAHOST parameter, you specify the host name on which the TREX instance should be started.

Example

stopsap.exe name=ABC nr=TRX77 SAPDIAHOST =pl23456
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12.3.2.4 UNIX: Using stopsap to Stop TREX

Procedure

1. Logonasuser<sapsid>adm.
2. Enter the following command:

stopsap <TREX_ instance>

Example
The following command starts a TREX instance with instance number 77:

stopsap TRX77

12.4 Uninstalling TREX

Context

You can uninstall the TREX server software using software provisioning manager (“the installer” for short).

Caution

When you uninstall TREX, the entire TREX directory is deleted, including all configuration data. If the index
directory and queue directory are located in the TREX directory, all indexes and queues are deleted.

Procedure

1. Logon as auser with the required authorizations:

Option Description

UNIX As a user with root authorizations

Windows As a user with administrator authorizations

2. Stop TREX (see Stopping TREX [page 109]).

It can take a while to stop the TREX processes. Make sure that all of the TREX processes have stopped
before you start the uninstallation process.
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7.

UNIX:

For an installation with an HTTP connection: Check that the Web server (HTTP daemon) has stopped. You
can use the following command to do this:

ps —fu trx<instance_number> | grep httpd

Start the installer.

For a detailed description of these steps, see Running the Installer [page 371].

Once the installer has started, navigate in the Welcome screen to the following directory:

|l <saP Product> j# Software Life-Cycle Options ¥ Uninstall # Uninstall - System /Standalone Engine /
Optional Standalone Unit 3

Inthe |+ SAP System @ General Parameters 4 screen, enter the path to the directory in which the SAP
system profiles are stored in the field |F SAP System Parameters » Profile Directory .

In the [ Uninstall » SAP System or Standalone Engine 3 screen, the TREX instances that you can uninstall
appear.

By choosing the options Remove all instances of the SAP system or standalone engine on this host? and
Remove OS user of SAP System or standalone engine on this host?, you can remove all TREX instances
together with the associated operating system users from your host.

You can only select the option Remove OS user of SAP System or standalone engine on this host?, if you
have already selected Remove all instances of the SAP system or standalone engine on this host?.
The installer displays the selected settings in the Start Execution screen:

© You can check the selected settings and choose Edit to change them if necessary.

o To start the uninstallation, choose Next .

Related Information

Using the SAP Management Console to Start TREX [page 106]
Using the SAP Microsoft Management Console to Start TREX [page 108]
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Important Disclaimers and Legal Information

Coding Samples

Any software coding and/or code lines / strings ("Code") included in this documentation are only examples and are not intended to be used in a productive system
environment. The Code is only intended to better explain and visualize the syntax and phrasing rules of certain coding. SAP does not warrant the correctness and
completeness of the Code given herein, and SAP shall not be liable for errors or damages caused by the usage of the Code, unless damages were caused by SAP
intentionally or by SAP's gross negligence.

Gender-Neutral Language

As far as possible, SAP documentation is gender neutral. Depending on the context, the reader is addressed directly with "you", or a gender-neutral noun (such as
"sales person" or "working days") is used. If when referring to members of both sexes, however, the third-person singular cannot be avoided or a gender-neutral noun
does not exist, SAP reserves the right to use the masculine form of the noun and pronoun. This is to ensure that the documentation remains comprehensible.

Internet Hyperlinks

The SAP documentation may contain hyperlinks to the Internet. These hyperlinks are intended to serve as a hint about where to find related information. SAP does not
warrant the availability and correctness of this related information or the ability of this information to serve a particular purpose. SAP shall not be liable for any
damages caused by the use of related information unless damages have been caused by SAP's gross negligence or willful misconduct. All links are categorized for
transparency (see: https://help.sap.com/viewer/disclaimer).
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https://help.sap.com/viewer/disclaimer

go.sap.com/registration/
contact.html

© 2018 SAP SE or an SAP affiliate company. All rights reserved.

No part of this publication may be reproduced or transmitted in any
form or for any purpose without the express permission of SAP SE
or an SAP affiliate company. The information contained herein may
be changed without prior notice.

Some software products marketed by SAP SE and its distributors
contain proprietary software components of other software vendors.
National product specifications may vary.

These materials are provided by SAP SE or an SAP affiliate company
for informational purposes only, without representation or warranty
of any kind, and SAP or its affiliated companies shall not be liable for
errors or omissions with respect to the materials. The only
warranties for SAP or SAP affiliate company products and services
are those that are set forth in the express warranty statements
accompanying such products and services, if any. Nothing herein
should be construed as constituting an additional warranty.

SAP and other SAP products and services mentioned herein as well
as their respective logos are trademarks or registered trademarks of
SAP SE (or an SAP affiliate company) in Germany and other
countries. All other product and service names mentioned are the
trademarks of their respective companies.

Please see https://www.sap.com/corporate/en/legal/copyright.html
for additional trademark information and notices.

Material Number:
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